WebSphere.

80 = )
@S
4 N

Clips and Tacks: Getting started with the IBM BPM suite of products



ii  IBM WebSphere Clips and Tacks: Getting started with the IBM BPM suite of products



Contents
Introduction
Overview

Build it yourself

Modeling . e
Create the business process .
Import the Lotus form
Build OrderHandling (Futurel) process
Connect the tasks.
Create the Notification Bus1ness Item .
Implement the Decision Branch Conditions
Set the input criterion for the process .
Implement the business rule for automatic
approval.

Specify monitoring crrterra by creatrng busrness

measures
Create the Percentage of Orders Shlpped
Business Performance Indicator .
Create the Average process Duration Bus1ness
Performance Indicator .
Create the Order Count Busmess Performance
Indicator.
Create the Sh1pped Order Count Bus1ness
Performance Indicator .
Create the Declined Order Count Bus1ness
Performance Indicator . .
Create the Order Price Total Busrness
Performance Indicator . .
Create the Order Price Average Bus1ness
Performance Indicator .
Export the model for use with WebSphere
Integration Developer .
Export the model for use with WebSphere
Business Monitor development toolkit .
Integration development

.11
. 2-1

. 3-1
.31
.31

. 3-6
. 3-11
. 3-14

3-15

. 3-19

. 320

. 3-23

. 323

. 3-26

. 3-28

. 3-28

. 329

. 3-30

. 331

. 3-32

. 3-35
. 3-37

Import model files into WebSphere Integration

Developer . .
Business process and busmess rules
development .
Generate Java components . .
Generate the user interface for the bus1ness
process . .

Deploy the Clips and Tacks Order Handhng

business process .

Test the Clips and Tacks Order Handhng bus1ness

process . .

Monitor the buslness process . .
Update the business process to emlt rnonltor
events

Create the monrtor rnodel to monltor the

business process . .

Complete the clipsbpm monltor model
Generate executable artifacts for the monitor
model and deploy to the server . .
Configure Action Services for business 51tuat10n
events .

Exercise the rnodel by runnlng events
Create the business dashboard
Debug information

Run the sample

Download the sample .

Importing the completed model into WebSphere
Business Modeler . .
Importing the completed model 1nto WebSphere
Integration Developer. .
Importing the completed WebSphere Integratlon
Developer project into WebSphere Integration
Developer e

. 3-38

. 3-41
. 3-48

. 3-52

. 3-53

. 3-54
. 3-59

. 3-60

. 3-62
. 3-70

. 3-81
. 3-84
. 3-87
. 3-88
. 3-96
. 41
. 5-1

. 5-1

.52

iii



iV IBM WebSphere Clips and Tacks: Getting started with the IBM BPM suite of products



Introduction

This end-to-end business dashboard tutorial introduces you to IBM® Business
Process Management (BPM) products by showing you how to build and deploy a
business process and configure a business dashboard to monitor that process. No
prior usage knowledge of the BPM products is required to complete the steps in
this sample.

[Printable version of this tutorial|

This tutorial focuses on the technical details that are related to building, running,
and monitoring the scenario provided. A single Lotus® form is used throughout the
process to convey information from one user to the next. You will use IBM
WebSphere® Business Modeler to model the sample and WebSphere Integration
Developer to complete the development, generate an end-user interface (or
business client) using Lotus Forms, and add monitoring to the sample business
process. You will use WebSphere Process Server to deploy the completed sample
and WebSphere Business Monitor to configure a dashboard to monitor the sample
business process. The sample culminates in a business dashboard and a business
process using IBM Lotus Forms.

In addition to this introduction, the tutorial has four major sections:

* Overview — Explains the scenario used in this sample, the data model, and the
Human tasks that are involved.

* Build It Yourself — Contains step by step instructions to build the sample from
scratch.

* Run the Sample — Explains how to run the sample using either the artifacts that
you download or the artifacts that you created in the Build It Yourself section.

¢ Download the Sample — Explains how to install the downloaded pre-built
solutions for this sample.

Time required

This tutorial could take approximately two days to complete, depending on your
familiarity with the products.

Skill level

This is a tutorial-style sample that has been designed for new users. Step-by-step
procedures are provided to guide you through the process development lifecycle,
from the beginning to setting up a test run time server and monitoring the data.
System requirements

This sample runs on Windows® operating systems.

Prerequisite software

Before you build the sample, you must install the following products. All of these
products can be installed on a single computer:

* WebSphere Business Modeler Advanced version 6.1
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* WebSphere Integration Developer version 6.1:
— You must apply iFix 001 for WebSphere Integration Developer.

— You must select WebSphere Process Server test server during the installation
process.

* WebSphere Business Monitor development toolkit version 6.1

* Lotus Forms Designer (shipped with WebSphere Business Modeler and
WebSphere Integration Developer)

* Lotus Forms Viewer (shipped with WebSphere Business Modeler and WebSphere
Integration Developer)

* Lotus Forms Server (shipped with WebSphere Integration Developer)

For more information about the products that are involved in this sample, refer to
the product documentation at the following link:

http:/ /publib.boulder.ibm.com /infocenter/dmndhelp /vérlmx/index.jsp|

Consider the following information when preparing to install your software:

* Install Lotus Forms Designer into WebSphere Business Modeler Advanced (Refer
to “Installing optional software” in WebSphere Business Modeler version 6.1
documentation:

http:/ /publib.boulder.ibm.com/infocenter/dmndhelp /v6rlmx /|
index.jsp?topic=/com.ibm.btools.help.modeler.doc/doc/install /installtopics /|
t install additional software.html|

¢ Install WebSphere Business Monitor development toolkit version 6.1 before
Lotus Forms Server.

* Install Lotus Forms Sever and Lotus Forms Viewer into WebSphere Integration
Developer (refer to “Installing optional software and documentation in
WebSphere Integration Developer version 6.1 documentation:

http:/ /publib.boulder.ibm.com/infocenter/dmndhelp /v6rimx /|
index.jsp?topic=/com.ibm.wbit.610.help.install.doc/ topics /|
t_install_additional_software. html|

When you install Lotus Forms Server, choose the WBMonSrv_wps profile.

Note: This tutorial uses admin as the user ID and admin as the password for the
dashboards.
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Overview

Clips and Tacks is a fictional office supply company. In this business scenario,
Clips and Tacks is processing orders for office supplies and shipping them to
customers.

The following sequence of events describes the Clips and Tacks business process
for handling incoming orders.

1. The business process is initiated when a customer submits an order.

2. A business rule evaluates the data from the order form and determines whether
the order can be automatically approved or if it needs human approval. When
the total purchase price of the order is $750.00 or less, the order is
automatically approved. When the total purchase price of the order is more
than $750.00, it is sent to a person for review.

3. For orders that are automatically approved, the customer account is checked to
determine if it is in good standing. If the customer account is in good standing,
then the order is sent for shipment; otherwise, the order is sent to a person for
review.

4. If the order is approved by the person, then it is sent for shipment; otherwise,
the order is cancelled and a notification is sent to the customer.

5. The orders that are ready for shipment are given a packaging slip number and
are sent to the customer.

Data model

The following information for the business process is stored in a business object
(also known as a business item) called Order:

¢ Customer information

* Items ordered

e Automatic approval field, which the business rule uses

¢ Field to include the status of the order

* The packing slip number, which is used to ship the order.

In the design phase, the Order business object is created automatically when the
Lotus Form is imported for use within the business process.

A Notification business object is used to send notification to a customer about a
canceled order. It has two fields: a text field and an e-mail field. In the design
phase, the Notification business object is created manually.

Human tasks

There are three human activities in this business flow:

* A human activity for entering data into the order entry form . This starts the
business process. This human activity is not modeled, it is the process-initiating
action.

* A modeled human task that represents the employee activity of reviewing the
order when the total purchase amount is more than $750.00 or when the
customer account is not in good standing.
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* A modeled human task that represents the employee activity of shipping the
order to the customer.
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Build it yourself

As you complete this sample tutorial, check your entries carefully. You might want
to work from a printed copy of the sample documentation so that you can
check-off each step as you perform it. (A PDF version of the documentation is
included with the artifacts that you download.) An experienced Business Process
Management (BPM) developer would be able to find mistakes, such as wrong or
skipped entries; however, a new BPM developer might have difficulty identifying
errors.

Before you begin, you must have installed all items listed under in

the Introduction section.

To download the following artifacts that are used in this section, refer to the

Download| section:

¢ Order.xfdl — the Lotus form used in this tutorial

+ CreditRating.java — a Java' file used in this tutorial. It is the implementation for
the task to check the customer account status.

Modeling

During the modeling phase, you will use WebSphere Business Modeler to build a
model that represents the Clips and Tacks business process for handling incoming
orders. There are several tasks to complete during this phase:

+ |Create the business process|

* [Import the Lotus form|

* [Build OrderHandling (Futurel) process|
+ |Connect the tasks|

* |Create the Notification Business Item|

* [Implement the Decision Branch Conditions|

* |Set the input criterion for the process|

* [Implement the business rule for automatic approvall

* |Specify monitoring criteria by creating business measureq

¢ |Create the Percentage of Orders Shipped Business Performance Indicator]|

* |Create the Average process Duration Business Performance Indicator]

* |Create the Order Count Business Performance Indicator|

* |Create the Shipped Order Count Business Performance Indicator|

+ |Create the Declined Order Count Business Performance Indicator]

* |Create the Order Price Total Business Performance Indicator

* |Create the Order Price Average Business Performance Indicator|

* [Export the model for WebSphere Integration Developer|
+ [Export the Model for Monitor Development Toolkif]

Create the business process

1. Start WebSphere Business Modeler Advanced Version 6.1. The Workspace
Launcher wizard opens.
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€5 Start Process Modeling

2. Create a new workspace for this tutorial, such as C:\Documents and

Settings\ Administrator \IBM\wbmodeler6.1\ClipsAndTacks. Do not select Use

this as the default and do not ask again so that you are prompted with this
dialog box each time on each launch. Click OK.

-1 Workspace Launcher
Select a workspace

IEM WebSphere Business Modeler Advanced Version 6.1 stores your projects in a folder called a workspace.,
Choose a workspace folder to use for this session.

Workspace: | C:\Documents and Settings\Administrator IBMwhbmodelers. 1\ClipsAndTacks| Iil [ Browse

[JUse this as the default and do not ask again

[ OK. l [ Cancel

3. On the Welcome window, click on Close Product Welcome to close the

Welcome window. The Start Process Modeling wizard opens.

4. Enter ClipsAndTacksF1 as the project name and OrderHandling (Futurel) as the
business process name. Click Next >.

Start modeling a new business process

Identify the new aor existing project and catalog {containers) for the business process. Then %
name the process that you want to model,

Project name
| ClipsAndTacksF1

Process catalog name
| Processes

Business process name
| OrderHandling (Future1)

Always show this wizard on startup

Launch Help

ack [ Mext = H Einish H Cancel

5. Clear Create business item and click Finish. The project and the business
process are created.
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The OrderHandling (Futurel) process is opened.

6. Click the Apply 4-Pane Layout icon =

€7 Business Modeling - OrderHandling (Future1) - IBM WebSphere Business Modeler ... |~ |03
File Edit Modeling View Mavigate Search Project Data Run  Window Help

T G @ i ge@  BB80:8 i 4 £ | G Business Mod.. |
3- @ i8] Blm e

X | & R W H
2 Proje... 2 = O || Z5 orderHandling (Future1) &3 =

ERER S

@
mE) o

-1 Predefined element:
~Elements
]
-
[ o
=
[ o M
e 3]
Diagram] Specification | Visual Attributes | Page Layout |
[il 1] ] [ll [ Attributes - Ord... 53 Business Measu. .. |513tic Analysis | Errors (Filter m... | =B
0% outline &2 =0 ‘ Cost and Revenue Duration Inputs Qutputs 4 »
= |§| General information e
—|| This section provides general information about this process.
Name
Description M
o* Selected Project: ClipsAndTacksF1

7. Select Modeling > Mode > WebSphere Process Server to ensure that the
model you are going to build can be imported into WebSphere Integration
Developer and later deployed to WebSphere Process Server. WebSphere
Business Modeler allows you to model for different run time environments.

0 Business Modeling - OrderHandling (Future1) - IBM WebSphere Business Modeler Advanced Vers
File Edit Modeling View Mavigate Search Project Data Run Window Help

1 il @ I New L A e R - Y 5 ¥
: v o (=] Mode ¥ [EBasic Alt+Ctrl+B
- gg Start Process Modeling... @Intermediate Alt+Ctrl H
%: Projecrmes—s — [@advanced Alt+Ctrl-+a
|£| B % :: WebSphere Business Integration Server Foundation  Alt+Ctrl+5
#-1zf: ClipsAndTacksF1 WebSphere MQ Workflow Alt+Ctrl+M
LE. Predefined elements (WebSphere Busir @WebSphere Process Server Alt+Ctrl 4P
[EJFileMet Business Process Manager Alt+Cirl+F

Import the Lotus form

1. Refer to the Download section to download the files needed in this tutorial,
such as the Lotus form.

2. In the navigation tree, expand ClipsAndTacksF1. Right-click Processes and
select Import.
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-
.- Project Tree &7
E‘IEE, ClipsAndTacksF1

..... fﬁ Business items
w138
----- Q_,si Resou New g
--{[@g Organ Import...

..... (& Classi{  Export...

EEI---[E Querie Reports. ..

..... LAl Busine Copy
#-(= Busine Rename
#- 13 Predefined Search...

Version b
Static Analysis  »
Fublish...

3. Select Lotus Forms (.xfdl, .xfd) and click Next.

‘ﬁ Web5Sphere Business Modeler Import

Select type
Select a product or format for impart and dick Mext.

Types

E*5WebSphere Business Modeler project {.mar, .zip)
E25WebSphere MQ Workflow Buildtime {,fdl)

E*5WebSphere Business Monitor results {,xml)
E25WebSphere Business Modeler XML { xml)

E2qWebSphere Business Integration Workbench v4.2.4 (.org)
E¥gRational Data Architect{, xsd)

E2gMicrosoft Visio (,vdx)

E¥yBusiness services and service objects {wsdl, .xsd)
E2gType definition XML schema (,xsd)

ExgDelimited text {.csv, txt)

Einish

4. Click Browse and select Order.xfdl from the list of files. Click Finish.
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0 WebSphere Business Modeler Import

Import options
Click Finish to import.

Source directory

| C:\Temp

M”Brnws&... ]

Files

E2gOrder, xfdl

Target project

ClipsAndTacksF 1

] ()

[ < Back ]| Mext =

)

Finish ] l Cancel

5. On the Import finished successfully dialog box, click OK.

The Lotus form is imported. The Order element under ClipsAndTacksF1 >
Processes is the imported Lotus form. The Order element under ClipsAndTacksF1
> Business service objects is the data element that was created automatically

during

import of the Lotus form.

&

-

o

ClipsAndTacksF 1
EE; Business items
% Processes

----- Sfi OrderHandling (Future 1)
Order

@?} Resources

--[[g§ Organizations

LE., Classifiers

EEI Reports

[E Queries

LE'., Business services

[Eq Business service objects
EIEQ Order

------ [j Customerfecord

= If? OrderTtem

------ If? OrderProcessingData
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Build OrderHandling (Future1) process

1. If the OrderHandling (Futurel) process is not open already, expand
ClipsAndTacksF1 > Processes and double-click OrderHandling (Futurel) to
open it.

Z-1zg ClipsAndTacksF1
EE] Business items
= % Processes
& OrderHandiing (Future1)
Order
[?.53, Resources

2. Right-click the start node O on the canvas and delete it.

3. Right-click the stop node @ on the canvas and delete it. You might have to
scroll to the right and down to see the stop node. From the palette, you can

reduce the size of the canvas by using the LK icon to reduce the width and
the & icon to reduce the height.

4. On the palette, click the Local Business Rules task icon 5! and then click the
canvas. Rename the local business rules task to Check Order Handling Policy
for Automatic Approval. You can resize the task to fully display the text if
you wish. As you add new elements, make sure that you add them to the
right of the previously added item. A figure with all the elements in the
process is included in the Connect (wire) the task section.

2 *0rdertanding (Future1) &3

 Elements
5
=)
&||& =
I'_] Check Order
T .
: Handling
Create local business rules Bolicy fo
task olicy for
* Cen Automatic
Approval
—_—
+ Annotation
LA

SR
d L

5. Click the Create simple decision icon % and then click the canvas. Rename
the simple decision to Approve Without Review?
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6. Click the Create local task icon and then click the canvas. Rename the
local task to Check Customer Account Status.

E~E *0OrderHandiing (Future1) 32

R? 50.0% Yes

+Elements

Le) N ES

Approve
Without

ey p Review?
=}
Check Order
- - Handling
Q H[I" Policy for @
= - Automatic 50.0% Mo
Sl [ Approval
— Check
a||e Customer
Account
Status
+ Connections
—

7. Click the Create simple decision icon <. and then click the canvas to the
right of the Check Customer Account Status task. Rename the simple
decision to Account in Good Standing?

8. Click the Create Merge icon ED* and then click the canvas.

.| Yo
Fork
Crei "[H§ o
v Merge
If you do not see the Create Merge icon in the palette, click the top left of the

elements on the canvas from left to right as you define them to align with
other steps later in this sample.

Note: Do not delete a merge element. WebSphere Business Modeler generates
names for the merge elements relative to when the merge element is added to

the canvas. In the monitoring design phase, these names are used to create the

monitoring model. Also, you can move the merge elements but do not change
the relative left-to-right position of two merges elements.
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5 =orderHandiing (Future1) &2

h 50.0% Yes
CEeeE 50.0% Yes
gg DecisionAp
prove Without
2||#
< | (2
=
o | Ty Check Order 50.0% Mo
W o Handling 50.0% Mo
a — Paolicy for
- Automatic
Approval
Check
 Connections Customer
Account
— Status
~Annotation
AN

9. Click the Create local human task icon and then click the canvas.
Rename the local human task to Review Order.

L 53
~Elements
gg 50.0% Yes
0.0% Yes
=G
& |13
- Approve
Without
+ Connections Review?
—
50.0% No
30.0% Mo
+ Annotation
i e G
]| |5 Check s
Customer D Review Order U
E 'D‘ Account
= Status
=
Rl
oo
@g( I

10. Right-click the Review Order task, select Associate Form. Click Browse and
select Order from the ClipsAndTacksF1 project. Then click OK.
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11.

€3 Select Form

Select a form

¥You can use F3 or F4 to highlight previously used forms.

= E ClipsAndTacksF1

=] iOrder ;

Ok

] [ Cancel

Leave the default. Use the input form as the output form selected and click
OK.

Build it yourself
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12.

13.

14.

15.

16.

17.

18.

9 Associate Form

Associate forms with this human task

[

Make one form the input and output farm, or select
different input and output farms for this human task.

Input form | Order | [Browse. .. :

Use the input form as the output form

Qubput form | | | Browse

Ok ] [ Cancel

Add a simple decision called Acceptable Credit Risk? to the canvas on the
right side of the previous item.

Add a Create Merge item to the canvas to the right of Acceptable Credit
Risk?
Add a local human task called Ship Order to Customer to the canvas.

Associate the Order form with the Ship Order to Customer human task in the
same way as you did for the Review Order human task.

Add a local task called Update Order Database to the canvas.
Ad a local task called Cancel Order and Send Notification to the canvas.

Add a Stop node by clicking the Create Stop icon @ on the palette and
then clicking the canvas. (If you do not see the Create Stop icon, then click
the top left of Create Start to expand the options.)

Add a second Stop node.

£s
= & O)
£

o,
[o*

0 '@ D
[Creste siop] —| Pdats Orcer O)

+ Connections

—»
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Connect the tasks

To connect the tasks means to wire the tasks.

To wire the tasks, click in the center of the input and output elements you are

wiring; otherwise a second input or output port may be created.

1. Click the Connections icon =—® in the palette, and then click the Input
Criterion item which is a rectangle on the outer left boundary of the canvas.
Click the input of the Check Order Handling for Automatic Approval task. A
wire connection is created.

£
2 |@
< | 3
< [0

=
®4

+ Connections

—»

CelIEI Create connection

Ll

r I

2. Click on the arrow icon

s

afal®

Chedk Order

Handling
Policy for
Automatic
Approval

the newly created connection and select Associate Data. Navigate to the
ClipsAndTacksF1 project, select Order, and then click OK.

Build it yourself

to move out of the connection mode. Right-click
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-} Type Selection

Select type
Click OK,
) Basic type
|Text M
® Complex type a2

1=l 1=F ClipsandTacdksF 1
EEJ Business items
LE'., Business services
=l [E“; Business service objects
= E] Order

[ij’ OrderProcessingData

Available states

[ Ok H Cancel ]

3. Wire the remainder of the process diagram by repeating steps 1 and 2 for all of
the elements. Review the Tips below before proceeding with wiring. All of the
links must have the Order business item, with the exception of the link from
Cancel Order and Send Notification to the Stop node.

Important: If Order [ ode is not automatically added to the link, add it using
the Associate Data context menu option before continuing with the wiring.

Tips
* To rearrange the elements, you can drag the elements on the canvas,

however do not change the relative left to right orientation of the merge
elements.

e Ctrl+Z orEdit » Undo will reverse your last change. This is preferable to
deleting for this tutorial.
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¢ The order of the wire creation from the simple decisions and merges is
important in order for the naming to work correctly in the monitor model.
Wire Yes’s before No’s for the simple decisions and tops before bottoms for
the merges.

¢ If the Connections wiring tool is still enabled, select the white arrow icon at
the top of the palette to enable the regular mouse pointer. (Before you try to
right-click an item, enable the regular mouse pointer.)

* To prevent yourself from inadvertently creating extra input or output ports
on the elements, click the center of each element that you are connecting.

The following three images show the completed wired diagram. The first image
shows the left half and the second image shows the right half. The third image
is the completed wired diagram.

Customer
Account
Status

CJ Order ——

ED'D;; Es C] Order

50.0% Yes L;j Order

Approve
Without
Review?

fj Order

@ |_‘_j Order

[ Order 50.0% No

Check Order
Handling
policy far
Automatic
Approval
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&=
Ship Order
to Customer

[57 Order
Update arder
Database
[Cj Order 50,0% Yes @

[ZJ Order

Review order

Acceptable .

Credit Risk?

Cancel Order
and Send

Cj Order notification

50.0% Mo

(3 order

4. Right-click the canvas and select Auto-Layout left to right. Save your work
with any of these choices:

¢ File > Save
¢ File > Save All
e Ctrl+S

Create the Notification Business Item

The Cancel Order and Send Notification task does not use Order as an output
business item. To send notification to customers that their orders have been
canceled, Clips and Tacks creates a new business item called Notification.

1. From the Project Tree, right-click Business items and select New ~» Business
Item.

2. Name the new business item Notification and click Finish.

3. Add two attributes, email and text, of type Text. Click Add and then click the
new attribute name and replace it with email. Repeat this step to add the
second attribute named text. Save your changes and then close the Notification
business item panel by clicking the X on its tab.
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| Notification

e o) v

Business item attributes

ibutes are properties or significant features, Inherited atiributes can only be edited in the parent template.

Mame Type Minimum Manimum Fead only Static o]
email || Text 1 1 False False Fa
text & | Text 1 1 False Falze Fz

) I |

4. Right-click the wire between Cancel Order and Send Notification and the Stop
node and select Associate Data. Select Notification from Business Items and
click OK.

50.0% Yes l.;_} Order

acceptable
Credit Risk?

1‘_'; Order

50.0%: No

Motification
Cancel Order @Iﬁ]—|—’
and Send

Motification

Implement the Decision Branch Conditions

1. In the process diagram, click the Approve Without Review? simple decision. In
the Attributes view, select the Attributes — Approve without Review? tab and
then click the Output branches tab.

< | i |
Disgram | Specification | Visual Attributes | Page Layout | Techrical Specification |

(s Atvibues - Approve Without Review? 57 Tednial Atibutes View | Business Mezsures | static Analysis | Errors (Fiter matched 0 of 0 tems)
/ General Inputs Outputs \JQY\ Input branches

Qutput branches

This section shows the output branches for this decision.

Name Contents Condition Probability (%)
Yes Output Yes 85.0
Mo Qutput:2 Mo 35.0

a. Click the Yes line and change the probability (%) to 65. Similarly, change the
No probability to 35. These probabilities are used during simulation.
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Because this tutorial is not using simulation, you can leave the other
probabilities at 50. This step was simply to demonstrate how to change the
decision branch probabilities.

b. Click the Yes line again. Scroll down to the Expression field and click Edit
(the panes in the 4-pane layout can be sized by selecting and dragging
borders). The Expression Builder wizard opens.

‘ Disgram | Specification | Visual Attributes | Page Layout | Technical Specfication |

- Attributes - Approve Without Review? I3 . Technical Attributes View | Business Measures | Static Analysis | Erors (Filter matched 0 of 0 items) ‘

Genersl Ious . oupus - purbanches 0 GUpURbEREREE

Decision Branch Condition

Name
[ ]

Description

Expression

c. In Expression Builder wizard, complete the following steps:
1) Click Add.

2) Under the Expression Composer section, ensure that Modeling artifact is
selected as the first term. Expand Process » OrderHandling (Futurel) -
Approve Without Review? » Input » OrderProcessingPreference and
select automaticApproval.

3) For Operator, select is equal to.

4) For the second term, select Boolean and set the Boolean value to true.

9 Expression Builder Q@

Decision branch condition X -EY

() A decision branch condition defines the rules that determine which decision branch to take. The built expression must evaluate to
"Boolean”, to be valid.

X
&y

Simple binary expression
Create a sequence of subexpressions, and specify the operators that connect the subexpressions. To create a more complex
expression, dick the Full Expression icon.
Operator Expression text
<lze the Expression Composer to create the expression. »
Expression Composer
First term: Operator: Second term:
Modeling artifact b -—-Select operator-- Boolean w
o] i | 5]
First term details: is not equal to Second term details:
Boolean value:
B TotalPrice m | true M|
OrderNumber —
E:En OrderStatus
=[] OrderProcessi
E:E automatics
[Ex Packingsliphiur| =
Orderltems
_ &0 ortem: M

5) Click Apply and then OK.
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EE OrderHanding (Future1) 52

<] m I

~ L
65.0% Yes 5
L [ order & = order ‘Accountin
= Customer Good
~Blements [i=] Account Standing?,
Check Order Y arder ‘Approve Status
@ | [%5 Handing D = '(\ Without
policy for T Review?
= Automatic 5 ord 50.0% Nao
(= =] Approval < [ ey ‘Er
(Ei =] 35.0% No

Diagram | Specification | Visual Attributes | Page Layout | Technical Specification |

[ Attributes - Approve WithoutReview? 2 . Technical Attributes View | Business Messures | Static Analysis | Errors (Filter matched 4 of 4items)

/ General Inputs Outputs Input branches _

Output branches
This section shows the output branches for this decision.

Name Contents Condition Probability (%)
Yes Cutput Yes 65.0
Mo Output:2 No 35.0
Details
HName
Contents
Name Assodated data State Minimum Maximum
Output Order 1 1

Decision Branch Condition

Hame

Description

Expression

“Processes, OrderHanding (Future1). Approve Without Review?. Input. OrderProcessingPreference. automaticApproval is equal to true

2. In the process diagram, click the Account in Good Standing? simple decision.
In the Attributes view, click the Output branches tab and change the Yes
probability to 85 and the No probability to 15
a. Select the Yes line, scroll all the way down, and click Edit under the

Expression field:

In the Expression Builder dialog box, complete the following steps:

b.

1)
2)

Click Add.

Ensure Modeling artifact is selected as the first term. Under First term
details expand Processes > OrderHandling (Futurel) » Account in

Good Standing? » Input and select TotalPrice.

For Operator select, is less than or equal to.

For the second term, select Modeling artifact and then expand
Processes » OrderHandling (Futurel) » Account in Good Standing? ~»

Input » Customer and select AvailableCredit.
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—~
& Expression Builder Q@
Decision branch condition X‘H‘Y
(1) A dedision branch condition defines the rules that determine which decision branch to take. P
i
simple binary expression =R
Create a sequence of subexpressions, and spedify the operators that connect the subexpressions, To create a more complex T
expression, dick the Full Expression icon.
Operator Expression text
'Processes.OrderHandling (Future 1). Account in Good Standing?. Input. TotalPrice' is less than or equal t...
Expi ion Comp - Root exp
First term: Operator: Second term: 7
‘ Modeling artifact] M‘ --5elect operator-- Modeling artifact M|
is equal to
First term details: is nat equal to Second term details:
iz greater than
is greater than or equal to
= is less than = ~
=2y Input U = i i E |;é| Post.a\CodEU
] Customer [ Email
E:u TotalPrice A E&n Rating
[ orderhiumber | B nvailabIaGEI
E:u OrderStatus E&n TotalPrice
) OrderPrDcessi\M |25 ordertiumber M
<] M I [L] < I | [l]
)

5) Click Apply and OK and then save your work.

3. Click the Acceptable Credit Risk? task. In the Attributes view, select the
Output branches tab.

a. Change the Yes probability to 70 and the No probability to 30.

b. Select the Yes line, scroll all the way down, and click Edit under the
Expression field.

c. In Expression Builder wizard, complete the following steps:
1) Click Add.

2) Ensure Modeling artifact is selected as the first term. Under First term
details expand Processes > OrderHandling (Futurel) » Acceptable
Credit Risk » Input and select OrderStatus.

3) For Operator, select is equal to.
4) For the second term, select Text and enter the value as APPROVED.
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9 Expression Builder Q@1

Decision branch condition

+
() A decsion branch condition defines the rules that determine which decision branch to take. The built expression must evaluate to X_; ’Y
"Boolean”, to be valid. -—

oy
&y

Simple binary expression

Create a sequence of subexpressions, and specify the operators that connect the subexpressions. To create a more complex
expression, dick the Full Expression icon.

Operator Expression text
<Use the Expression Composer to create the expression. >

Remove

Expression Composer
First term: Operator: Second term:
Modeling artifact w —Select operator— Text '
] | cooec | ]
First term details: is not equal to Second term details:
Text value:
E-E Input [w] [aPPROVED]

] Customer
E:n TotalPrice
[z orderiumber H
E:n OrderStatus

] OrderProcessin,
.
< ] 1

OK Cancel

5) Click Apply and then OK and then save your work.

Set the input criterion for the process

To ensure that the process initiator doesn’t wait for a response, set the operation
type of the Input Criterion to One way by completing the following steps:

1.

2.

Click the canvas and then click the Technical Attributes View tab and then the
Request tab.

Select the Input Criterion row.

For Operation type, select One way operation and save your work.

| Diagram ] Spedification | Visual Attributes | Page Layaut| Technical Specification |

T = = 5 5
Attributes - OrderHandling {Future 1) | Business Measures | Static Analysis | Errors (Filter matched 0 of 0 items) | i Technical Attributes View 22 \ \E_,f ¥ =0

( General \'\\‘ Interface _ Response - Implementation -

¥ Input criterion section

Select an input criterion in the table to see the WSDL and BPEL information in the sections below

Input criterion name Corresponding output ait... | Valid operation type Selected operation type
Input Criterion Qutput Criterion Request /response, one ...  One way

¥ Operation type
Select the type of operation

O Request / Response operation
& One way operation
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Implement the business rule for automatic approval

The business rules task uses the Order business object as the input and checks the
TotalPrice variable. If the total price is not greater than a specified fixed amount (in
this case, $750.00), then the rules task sets the automaticApproval variable in the
business rules component to true; otherwise, the variable is set to false. The

business rules component returns the modified Order business object as the
output.

Implement the business rules task by completing the following steps:

1. In the process diagram, click the Check Order Handling for Automatic
Approval task and then, in the Attributes view, click the Business Rules tab.

2. Click Add. The Define Business Rule wizard opens.

3. Enter AutomaticApprovalFl as the name of the business rule.

4. Click the Rule Templates tab and then click Add Template.

5. Change the template name from Rule template:1 to AutoApproval Template
by selecting the name and typing over it.

6. Under Rule parameters, click Add.

7.

Define the rule parameter by completing the following steps:

a. Change the parameter name to totalPriceMax by selecting it and typing
over the generated name.

b. Select Decimal (double-precision) as the type.

For the description, enter maximum purchase for automatic approval.

9 Define Business Rule E]@

Specify the rule logic as a set of if-then rules

Create or modify one or more if-then rules that define the logic of the business rule. To create rule conditions and actions, the business rules task must have inputs and outputs defined.

~
Name
AutoApprovalF 1
Description

Important
To reuse rule conditions and actions or allow their parameter values to be changed in an application at runtime, create a rule template.

Definition

To specify rule conditions and actions, create any required rule parameters. Also ensure that the business rules task has inputs and outputs defined.

Template name Rule condition Rule action Template description

AutoApproval Templat <Type the description h| Add Template
Remave Template

Rule parameters

To chanae parameter values at runtime or add parameters to either the rule condition or action, spedfyv rule parameters, Add constraint information as a description.

Parameter name Type Desaription

totalPriceMax Decimal (double-precision) masimum purchase for automatic approval]
Rule template presentation
Determine how the rule template is presented to users at runtime for modification of the rule parameter values.
() Automatically generate the text for the rule template presentstion
{2 Customize the text for the rule template presentation
&)

8. Returning back toward the top of the wizard, under Important > Rule ~»
Templates » Definition in the table, click the rule condition cell for

AutoApproval Template and then click E to open a Rule Condition
wizard. This is a common way to launch a wizard.
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9. In the Expression Builder (for the rule condition), complete the following
steps:

a.

Add a simple binary expression by clicking Add.
b.

For the first term, select Modeling Artifact. Expand Check Order
Handling Policy for Automatic Approval » Input and select TotalPrice.
c. For the Operator, select is less than or equal to.

For the second term, select Modeling Artifact. Expand Check Order
Handling Policy for Automatic Approval and select totalPriceMax.

{1 Expression Builder

Rule Condition LV
. X+Y
() In an if-then rule, a rule condition must be satisfied for a rule action to take effect. The built expression must evaluate to "Boolean”, to be valid. X
iy #
Full expression ] |_‘
Use the Expression Composer to create each subexpression. To areate a simple binary expression, dick the Simple Expression icon.
Exp oy Expression text:
< <Empty expression>
<<Empty expression> >
Expression Composer
First term: Operator: Second term:
‘ Modeling artifact [1“ -Select operator—- Modeling artifact M‘
is equal to
First term details: is not equal to Second term details:
is greater than 5
is greater than or equal to Modeling artifact:
T || is less than = - "
=) Input ] || St e T = ) Check Order Handing Policy for Automatic A
(5] Customer I:l T Input
B TotalPrice 3 © Output
E:: OrderMumber F':.ul totalPriceMax
[Es orderstatus [v]
< Im &) < I E)

e. Click Apply and OK.

10. Click in the Rule action cell for AutoApproval Template and then click the

11.

edit icon k-

Definition

To specify rule conditions and actions, create any required rule parameters. Also ensure that the business rules task has inputs and outputs defined.

Template name Rule condition

AutoApproval Templat'Chedk Order Handling Policy for Automatic Approval.Inp

Rule action

Template description

(2] <Type the description b
Remave Template

The Specify Rule Action wizard opens.

Specify the rule action by completing the following steps::
a. Expand and select Check Order Handling Policy for Automatic Approval

> Output » OrderProcessingPreference » automaticApproval. Then select
Value specification » Specific value and True. Click OK.
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&P Specify Rule Action

[B][=1/ ]

Spedify the details of the rule action

The rule action is performed when the rule condition is true. For each part of the rule action, assign a value.

Details Value specification
For task inputs and outputs, assign a value to the input, the output, or one or more input or output attributes. The value must match the type.

Name Type Minim... | Maxi.. | Value
1=l (=) Check Order Handiing for Automatic None
ER3) Order

O none
® specific value

CustomerRecord \ True

Deamal (double-pr.

Integer (ong) © Expression

Text
OrderProcessingD. ..
Text
OrderTtem
Order
CustomerRecord
Decmal (double-pr...
Integer (long)

[Es OrclerStatus Text
= (°] OrderPracessingPreference OrderProcessingD..
Boolean
[ PackingSliphumber Text
(3 orderitems Orderltem
5 totalPriceMax Decimal (double-pr. ..

BN EOROOEEEnOss
Bl I e

The following figure shows the completed business rule.

&P Define Business Rule

LJoEs

Specify the rule logic as a set of if-then rules

Create or modify one or more if-then rules that define the logic of the business rule. To create rule conditions and actions, the business rules task must have inputs and outputs defined.

I*

AutoApprovalF 1

Description

Important
To reuse rule conditions and actions or allow their parameter values to be changed in an appication at runtime, create a rule template,

Definition

To spedify rule conditions and actions, create any required rule parameters. Also ensure that the business rules task has inputs and outputs defined.

Template name Rule condition Rule action Template description
AutoApproval Templat'Check Order Handling Policy for Automatic Approval. IrCheck Grder Handing Policy for Automatic Approval.O<Type the description b

Rule parameters

Parameter name Type Desaiption
totalPriceMax Decimal {double-precision) maximum purchase for automatic approval

To change parameter values at runtime or add parameters to either the rule condition or action, specify rule parameters. Add constraint information as a descrintion,

Rule template presentation

Determine how the rule template is presented to users at runtime for modification of the rule parameter values.
(%) Automatically generate the text for the rule template presentation

() Customize the text for the rule template presentation

Add Template
Remove Template

Remove

If ‘Check Order Handing Palicy for Automatic Approval. Input.TotalPrice’ s less than or equal to ‘totalPriceMax,
then 'Chedk Order Handing Policy for Automatic Approval. Output.OrderProcessingPreference. automaticApproval is set to True

]

: Cancel

12. Close the Define Business Rule wizard by clicking OK again.

13. In the Attributes view, select the Business Rules tab and scroll down to the

Default business rule section. In the selection list, select
AutomaticApprovalF1. Save your work.
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5 Attributes - Check Order Handling for ... 52 _ Business Measures | Static Analysis ! Errors {Filter matched 0 of 0 items) | Technical Attributes View | =

=)

| General ‘ Costand Revenue . Duration - Inputs ‘ Outputs m Resources . Organizations . 4

Identify the highdevel business rules associated with the task.

Business rule Description
iAutomaticApprovalF 1
Scheduling

Specify which business rule should be used by default and which business rules are in effect on specific dates. Dates are set in local time zones, so the
scheduling of business rules in an application at runtime occurs in the local time zone.,

Default busii rule

Business rules b]

»

AutomaticApprovalF 1 |_‘L“

Scheduled busin rules
Start date End date Business rule

(]

Specify monitoring criteria by creating business measures

Business measures are used to specify what should be monitored in the business
process. Complete the following steps to specify what should be monitored:

1.
2.
3.

Select Window » Show View » Business Measures.
Within the Business Measures view, select the Monitored Values tab.

In the % Per Branch column in the table, select the three check boxes (See the

image in the next step.)

In the Processing Time column, select the seven check boxes and then save
your work. The other columns usually require additional resource properties

be specified for each task, but these other properties are not part of this sample.

to

| Dlagram] Specification | Visual Attributes ‘ Page Layout ‘ Technical Specification |

Attributes - OrderHandling (Future 1) m Business Measures ©3 Static Analysis ‘ Errors (Filter matched 0 of 0 items) | Technical Attributes View |

=0

(Businass Performance Indicators

Monitored values

This section indicates which values you want returned from WebSphere Business Monitor after the process has been monitored.

Process Element Processing Time: Processing Cost Startup Cost Revenue % Per Branch
Q Acceptable Credit Risk? ¥
<5, Account in Good Standing? ]
<2 Approve Without Review? E
(=) Cancel Order and Send Notification ] | O O

(=) Check Customer Account Status ] O | |

= Check Order Handling for Automatic Approval E| |:| D D

&'ou OrderHandling {(Future 1) El I:l D D

7 Review Order (] O O O

H’T—)Shin Order to Customer E‘ D D D

(Z-iUpdate Order Databse El |:| D D

Create the Percentage of Orders Shipped Business
Performance Indicator

Create the Percentage of Orders Shipped KPI by completing the following steps:

1.
2.

Click the Business Performance Indicators tab and then click Add.

In Business Measure Details — Measurel wizard, enter the name Percentage
of Orders Shipped.

Select Type as KPI.
For the Description, enter Percentage of orders that are shipped.
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5. Expand Dashboards and preview the different KPI representations. You can
select each of the highlighted values (for example, KPI Gauge or KPI Bar, to
see how the KPI is represented as a gauge or bar graph. The Type field above
the Dashboard section also lists other monitoring types, such as KPI, Instance
Metric, Aggregate metric, and Unspecified. You can change the selection from
KPI to one of the other values to see the various ways that they are displayed
on a dashboard. When you are finished exploring the Dashboards section,
ensure that the Type field under the Name field is selected as KPI before

proceeding.
N - s ol
[ii4 Business Measure Details - Percentage of Orders Shipped
Business Measure Details
® Specify additional details to describe how the business measure is calculated.
A~
Optionally, you can create a business measure by applying a predefined template to a process element.
Template | Unspecified [v]
Hame | Percentage of Orders Shipped
Type @ KkpI O Instance metric O Aggregate metric O Unspedified B
Description |Percentage of orders that are shipped|
¥ Dashboards
Dashboards present continuously updated business measures data in a graphical format to make it easy to track process performance.
A KPIis calculated across multiple runs of the process and is used to track business objectives. Examples of KPIs and their targets are
"Average time for response to a customer inquiry” with a target of “less than two days”, "Achieve target profit” with a target of
"£65000," or "Reduce employee turnover™ with a target of "5%". This type of data can be displayed in the following dashboards:
P17zble:  Displays details of modeled Key Performance KPI Table -
Indicators (KPIs) such as KPI value relative to
the defined ranges and the target, if
appiicable, and the status. KPI Name Status Value Target Range
Displays an individual KPI value, relative to the
KPI range and targetin a full or half gauge SREE o 2l e _—
format, if applicable. — am _— =
Displays an individual KPI value, relative to the
KPI range and targetin bar format, if
applicable. Percentage 3 550 Em—
Alerts: Displays alerts that notify users of defined Totsl Ord 390.0 1000
situations ocourring at run time, oral Drder o 1
zl: Provides a multidmensional view of business [< ] [ i} | [)]
performance data. Charts and grids present T —r
data for analysis against different dimensions.
Report Displays performance reports relative to a time
axis. Such reports typically contain tables and
graphs with textual descriptions of the analysis.
v
(& Im | [2

6. Select Specify a target value and type. Select the type as Number and change
Target value to 90.

7. Check Specify range details. Select Percentage of target value (target value =
100%).

8. Under Specify ranges, click Add. In many tables like this one that have an
Add button, you can click Add or double-click in a row in the table to add a
row. Change the Range name to Shipped orders percentage too Tow. Set the
start value to 0 and the end value to 85. Perform the same actions for the
following ranges:

Range name Start value End value
Shipped orders percentage good 85 90
Shipped orders percentage great 90 100
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10.

11.

12.

Check Specify a time period over which the business measure will be
monitored. Select Rolling and Last 30 days.
Check Specify when to send an alert and the action to take as a result. Click
Add. The Percentage of Orders Shipped Alert is added. Change it to
Percentage of Orders Shipped < 85%.
Check Select the dimension to be used as filters and add the values of
interest. Change the Dimension name to Location. Select Location.

Click OK and save your work.

-

[is! Business Measure Details - Percentage of Orders Shipped

Business Measure Details
(D) Spedify additional details to describe how the business measure is calculated.

Optionally, you can create a business measure by applying a predefined template to a process element.

Template | Unspecified [v]
Name ‘ Percentage of Orders Shipped |
Type & KPI  Instance metric ) Aggregate metric ! Unspecified

Description | Percentage of orders that are shipped

P Dashboards

Specify a target value and type
The target is an exact value that the KPI should achieve.

Type: Mumber [vl

- [
Target value: |90 ==

Specify range details:
Ranges can be defined as percentages of the target value or as fixed, actual values.

(3) Percentage of target value (target value = 100%)

Period bype: last[30 [ 2 days ]

Time zone;

= ]

Base period o

O Actual value

Specify ranges

Arange is a set of values, such as allowable margins or lower and upper limits, against which to track your KPI.
Range name Start value End value
Shipped orders percentage too low 0% < 85 %
Shipped orders percentage good 85 % <90 %
Shipped orders percentage great 90 % 100 %

Specify a time period over which the busi e will be itored
() Repeating (%) Roliing () Fixced
Start date:

[

End date;

L e

Time zane:
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Specify when to send an alert and the action to take as a result
For example, when this measure exceeds a certain value, an email may need to be sent.
Alert Description
Percentage of Orders Shipped <85%
Select the dimensions to be used as filters and add the values of interest
For example, you have a City dimension but only want to indude values from New York and Los Angeles. 3
Dimension Values to Indude
Location
w

Create the Average process Duration Business Performance

Indicator

Create the Average Process Duration KPI by completing the following steps:

1.
2.

—

—_
—_

12.
13.

14.

15.

© ©®X®NOO MO

Add a new Business Performance Indicator by clicking Add.

In the Business Measure Details — Measurel wizard, enter the name Average
Process Duration.

Select Type as KPIL.

Enter Description as Measure average time of business process duration.
Check Specify a target value and type.

Select type as Duration.

Select Target value as 3 days.

Check Specify range details.

Select Actual value.

Under Specify ranges, click Add. Change the range name to Duration is
acceptable. Start value: 1 Day. End value: 3 days.

. Click Add again. Change the range name to Duration too long. Start value: 3

Days. End value: 5 days.

Tip: Besides clicking Add to add a row to a table, you can also double-click a
row to add a row.

Check Specify when to send an alert and the action to take as a result.

Click Add. It adds an Average Process Duration Alert. Change it to Average
Process Duration >3 days.

Check Select the dimension to be used as filters and add the values of
interest.

Click Add. Change the Dimension name to Location. Check the Location.
(The completed view is shown in the following 2 images.)
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]

[is! Business Measure Details - Average Process Duratiopn

Business Measure Details
@ Specify additional details to describe how the business measure is calculated.,

>

Optionally, you can create a business measure by applying a predefined template to a process element,

Tempiate

Name ‘ Average Process Duratiopn

Type @ KpPI O Instance metric O Aggregate metric O Unspecified

Description | Measure average time of business process duration

¥ Dashboards

Specify a target value and type
The target is an exact value that the KPI should achieve.

Type: Duration M
Days Hours Minutes Seconds Miliseconds

ot [Teed [0 bad [0 o) [ ) [0t

Specify range details:
Ranges can be defined as percentages of the target value or as fixed, actual values.
() Percentage of target value (target value = 100%)
(® Actual value

Specify ranges

Arange is a set of values, such as allowable margins or lower and upper limits, against which to track your KPI.

Range name Start value End value

Duration is acceptable 1Day 0 Seconds < 3Days 0 Seconds

Duration too long 3 Days 0 Seconds < 5Days 0 Seconds

[[] Specify a time period over which the busi will be itored

Fetind bype: Last |: - l:l Start date;
[erv sl |
Time: 2one: End date;

Ease petiod on: Time zone: M

Specify when to send an alert and the action to take as a result

For example, when this measure exceeds a certain value, an email may need to be sent.

Alert Description
Average Process Duration > 3days

Select the dimensions to be used as filters and add the values of interest

For example, you have a City dimension but only want to include walues from Mew York and Los Angeles.

Dimension Values to Include
Location

16. Click OK and save your work.

Build it yourself 3-27



Create the Order Count Business Performance Indicator

Create the Order Count Business Performance Indicator by completing the
following steps:

1. Click Add to add a new Business Performance Indicator.
Enter the name as Order Count.

Select Type as Aggregate metric.

Enter Description as Count the number of orders processed.

A A

Expand the Dashboards tab to get a preview of how an Aggregate metric can
be visualized on a Dashboard as a Dimensional or Report view.

6. Check Specify how this measure is aggregated across multiple runs of the
process.

7. Select Function as Count.

8. Check Specify the categories that will be available in the dashboards for
analysis of the metric. Keep the Dimension as Location. The completed item is
shown below.

[s! Business Measure Details - Order Count

Business Measure Details
(1) Specify additional details to describe how the business measure is calculated.

Optionally, you can create a business measure by applying a predefined template to a process element.

Template ‘ Unspedfied [v]|
Hame | Order Count
Type QO KPI ) Instance metric (©) Aggregate metric ) Unspecified

Description | Count the number of orders processed

¥ Dashboards

Specify how this measure is aggregated across multiple runs of the process:

This can be used for historical analysis in the Dimensional view.

Specify the categories that will be ilable in the dashboards for lysis of the metric

For example, location, city, or sales representative.

Dimension
Location

9. Click OK and save your work.

Create the Shipped Order Count Business Performance
Indicator

Create the Shipped Order Count Business Performance Indicator by completing the
following steps:

1. Click Add to add a new Business Performance Indicator.
2. Enter the name as Shipped Order Count.
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7.

Select Type as Aggregate metric.
Enter Description as Count the number of orders shipped.

Check Specify how this measure is aggregated across multiple runs of the
process. Select Function as Count.

Check Specify the categories that will be available in the dashboards for
analysis of the metric. Keep the Dimension as Location. The completed item is
shown below.

[is! Business Measure Details - Shipped Order Count

Business Measure Details
(1) Specify additional details to describe how the business measure is calculated.

Optionally, you can create a business measure by applying a predefined template to a process element.

Template ‘ Unspecified [,,“
Name | Shipped Order Count
Type (O KPI () Instance metric (&) Aggregate metric ) Unspecified

Description | Count the number of orders shipped|

¥ Dashboards

Specify how this measure is aggregated across multiple runs of the process:

This can be used for historical analysis in the Dimensional view.

Specify the categories that will be ilable in the dashboards for lysis of the metric

For example, location, city, or sales representative.

Dimension
Location

Click OK and save your work.

Create the Declined Order Count Business Performance

Indicator

Create the Declined Order Count Business Performance Indicator by completing
the following steps:

1.

A

Click Add to add a new Business Performance Indicator.
Enter the name as Declined Order Count.

Select Type as Aggregate metric.

Enter Description as Count the number of orders declined.

Check Specify how this measure is aggregated across multiple runs of the
process. Select Function as Count.

Check Specify the categories that will be available in the dashboards for
analysis of the metric. Keep the Dimension as Location. The completed item is
shown below.
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Ui} Business Measure Details - Declined Order Count
Business Measure Details
@ Specify additional details to describe how the business measure is calculated.
Optionally, you can create a business measure by applying a predefined template to a process element.
Template |Unspedfied [~]
Hame | Dedlined Order Count
Type O kp1 O Instance metric (2) Aggregate metric O Unspecified
Description | Count the number of orders declined
¥ Dashboards
Specify how this measure is aggregated across multiple runs of the process:
This can be used for historical analysis in the Dimensional view.
Function: | Count [v]
Specify the categories that will be ilable in the dashboards for lysis of the metric
For example, location, city, or sales representative.
Dimension
Location

7. Click OK and save your work.

Create the Order Price Total Business Performance Indicator

Create the Order Price Total Business Performance Indicator by completing the
following steps:

1.

Al S

Click Add to add a new Business Performance Indicator.
Enter the name as Order Price Total.

Select Type as Aggregate metric.

Enter Description as Total value of the orders.

Check Specify how this measure is aggregated across multiple runs of the
process. Select Function as Sum.

Check Specify the categories that will be available in the dashboards for
analysis of the metric. Keep the Dimension as Location. The completed item is
shown below.
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[lu} Business Measure Details - Order Price Total

Business Measure Details
@ Specify additional details to describe how the business measure is calculated.

Optionally, you can create a business measure by applying a predefined template to a process element.

Template |Unspecified v
HName | Order Price Total
Type (O KPI ) Instance metric (=) Aggregate metric O Unspecified

Description | Total value of the orders

¥ Dashboards

Specify how this measure is aggregated across multiple runs of the process:

This can be used for historical analysis in the Dimensional view.

Spedify the categories that will be ilable in the dashboards for lysis of the metric
pec eg
For example, location, city, or sales representative.
Dimension
Location

7. Click OK and save your work.

Create the Order Price Average Business Performance
Indicator

Create the Order Price Average Business Performance Indicator by completing the
following steps:

1. Click Add to add a new Business Performance Indicator.
Enter the name as Order Price Average.

3. Select Type as Aggregate metric.
4. Enter Description as Average value of orders.
5. Check Specify how this measure is aggregated across multiple runs of the

process.. Select Function as Average.

6. Check Specify the categories that will be available in the dashboards for
analysis of the metric. Keep the Dimension as Location. The completed item is
shown below.
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Ui} Business Measure Details - Order Price Average

Business Measure Details
@ Specify additional details to describe how the business measure is calculated.

Optionally, you can create a business measure by applying a predefined template to a process element.

Template |Unspedfied [~]
Hame | Qrder Price Average
Type O kp1 O Instance metric (2) Aggregate metric O Unspecified

Description | Average value of the orders

¥ Dashboards

Specify how this measure is aggregated across multiple runs of the process:

This can be used for historical analysis in the Dimensional view.

Specify the ca

For example, location, city, or sales representative.

Dimension
Location

7. Click OK and save your work.

The business performance indicators that you added should look like the
indicators in the following image.

Attributes - OrderHandiing (Future1) | [m Business Measures o5 . Static Analysis ! Errors (Filter matched 0 of 0 items) 3 Technical Attributes View = =
: s . Monitored Values .
~
Business measures summary —
This section provides information about business measures such as metrics and KPIs,
Name Type Target Time Period Description
Ul Average Process Duratiopn KPT 3Days 0S... Measure average time of business process duration
Ulln Percentage of Orders Shipped KPI 90 Rolling: 30 days Percentage of arders that are shipped L
IriOrder Count ‘Aggregate metric Count the number of orders processed
{riShipped Order Count Aggregate metric Count the number of orders shipped
‘ irriDedined Order Count Agagregate metric Count the number of orders declined
Il Order Price Total Aggregate metric Total value of the orders
izmiOrder Price Average Aggregate metric Average value of the orders
[
[<] I (2]

Export the model for use with WebSphere Integration
Developer

You have completed modeling the Clips and Tacks business process. Next you will
export this model from WebSphere Business Modeler and import it into WebSphere
Integration Developer for further development.

Export the model by completing the following steps:

1. Ensure that there are no errors in the model, as listed the Errors tab. If there are
errors, then correct them before proceeding to the next step.
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| Diagram] Speﬁmﬁon | Visual Attributes | Page Layout| Technical Specification |

[nttribuhes - OrderHandling (Future1) | Technical Attributes View | Business Measures | Static Analysis [‘Ig) Errors {Filter matched 0 of 0 items) &2

Description Element name Element type Parent project Parent name

2. Right-click ClipsAndTacksF1 on the Project Tree and select Export.

?} WebSphere Business Modeler Export

Select the format or product to which you want to export

Export model elements for use with WebSphere Integration Developer in
creating an implementation for WebSphere Process Server, Before you use this

\

=

Types

£ WebSphere Business Modeler project {.mar)

i “‘WebSphere Integration Developer :

£ WebSphere MQ Workflow Buildtime (fdl)

£ WebSphere Business Monitor Development Toolkit {.mm)

£ WebSphere Business Modeler XML {xml)

£ WebSphere Studio Application Developer Integration Edition
£ FileMet Business Process Manager {.xpd)

£ FR.ational Data Architect

EUML Business Modeling Profile

B Delimited text {.cev, .txt)

mn

=
Tl

@

Cancel

3. Select WebSphere Integration Developer and then click Next.
4. Select a target directory (for example, C:\ClipsAndTacks).
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& WebSphere Business Modeler Export

Export options
Ensure that the reference groups for the selected projects are correct and dlick Mext to
continue 1

Target directory
| C\ClipsandTacdks M| [Browse. = ]

() Export entire project and related projects
O Export specific elements

iy

[¥]l=* ClipsAndTacksF1

] Enable default events

] overwrite files

s [ o> ] o

5. Select Export entire project and related projects and click Next.
6. Select the Module export option.

7. Clear Append timestamp to project interchange name (so that it is easier to
define the name in this sample).
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& WebSphere Business Modeler Export

‘WebSphere Integration Developer export details

Business Modeler and WebSphere Integration Developer,

Spedify export details, then click Finish to export. Use the recommended export option for interoperability between Websphere gjg
Select the export option
Module

[v]
This option creates a single module project. Choose this option only if you have a small model with simple processes, for example
for a proof of concept application.

Project Interchange Name

Export using the standard project interchange format for other environments
[ClipsandTacksF1

[ Append timestamp to project interchange name

Target Project Names
Modeler Project Mame Module MName
iClipsAndTacksF1 ClipsAndTacksF1

8. Click Finish.

< Back

][ Next > H Finish H Cancel

Verify that ClipsAndTacksF1.zip was exported to the directory you selected.

development toolkit

Export the model for use with WebSphere Business Monitor

Next you will export the ClipsAndTacks files to develop a monitor model that will
monitor the business process that you created a model for:
1.

In the project tree, right-click ClipsAndTacksF1 and select Export.
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@ WebSphere Business Modeler Export

Select the format or product to which you want to export

Export a preliminary monitor model to refine in the WebSphere Business Monitor
Development Toolkit and then deploy to WebSphere Business Manitor,

\

=

Types

£ WebSphere Business Modeler project {.mar)

£ WebSphere Integration Developer

£1'WebSphere MO Workflow Buildtime {. fdl)

- "WebSphere Business Monitor Development Toolkit (.mm) |
£ WebSphere Business Modeler XML {,xml)

£1'WebSphere Studio Application Developer Integration Edition
£ iFileMet Business Process Manager (,xpdl)

£ Rational Data Architect

£ UML Business Modeling Profile

EDelimited text {csv, txt)

Cancel

2. Select WebSphere Business Monitor Development Toolkit (.mm) and click

Next.
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& WebSphere Business Modeler Export

Destination and Source
Choose a target directory,

Target directory
|C:'|,C|ips.ﬁ.ndTadcs Ml [Bruwse... ]
Project
| ClipsAndTacksF 1 M|
) Export entire project

(%) Export specific elements

&

=l @ Processes
P iorderHandling (Future 1)

[ | overwrite files

Mext Einish l [ Cancel

Select a target directory, for example c:\ClipsAndTacks.

Select Export specific elements.
Expand Processes and select OrderHandling (Futurel).

Click Finish.

ook w

Close WebSphere Business Modeler after you verify that the following files were
created in the target directory:
OrderHandling (Futurel). mm
OrderHandling_ x0028_ Futurel_x0029__KM_OrderHandling_ x0028_
Futurel_x0029__KC.svg
OrderHandling_ x0028_ Futurel_x0029__MDM_OrderHandling_ x0028_
Futurel_x0029__MC.svg

Integration development

During the integration development phase, you will use WebSphere Integration
Developer to develop a business process and business rules, generate Java
components, and create the user interface. Tasks to complete during this phase:

Import model files into WebSphere Integration Developeﬂ

» [Business process and business rules development|
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* |Generate Java components|

* |Generate the user interface for the business process|

Import model files into WebSphere Integration Developer

Now you will import the exported file (from WebSphere Business Modeler) into
WebSphere Integration Developer.

1. Start WebSphere Integration Developer Version 6.1. The Workspace Launcher
opens.
& Workspace Launcher

Select a workspace

IBM WebSphere Integration Developer &, 1 stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

Workspace: | C:'\Documents and Settingsadministrator \IBM wids. 1\ClipsAndTacks [v] [ Browse...

[ ]uze this as the default and do not ask again

I OK H Cancel ]

2. Create a new workspace for this sample. For example, C:\Documents and

Settings\ Administrator \IBM\wid6.1\ClipsAndTacks.

Note: Do not select Use this as the default and do not ask again so that you

will be prompted for a workspace location each time you open the application.

. Click OK. WebSphere Integration Developer opens. If the Welcome page is
displayed, close it before proceeding.

. Import ClipsAndTacksF1.zip by selecting File » Import. You can use the
ClipsAndTacksF1.zip file you have created with the previous tasks, or you can
use the ClipsAndTacksF1.zip that is provided with this sample.
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Edit Mavigate Search Project Data
Mew Alt+Shift+4 ¥
CQpen File...
Close Ctrl+wy
Close all Cirl+5hift+w
[E] save Ctrl+5
B save as...
) save Al Ctrl+5hift+5
Revert
Mave...
Rename... F2
Refresh F5
Convert Line Delimiters To ¥
i Print... Ctrl+p
Switch Workspace. ..

£ Export...

Properties

Alt+Enter

Exit

The Import wizard opens.

5. Select Other » Project Interchange and click Next.
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@ Import E3

Select \
Import a project and its dependent projects from a Zip file. | ! - E I

Select an impart source:
| type filter text |

[z General
-7 Business Integration
= Vs
[ EJB
= J2EE
[z Plug-n Development
(= Profiing and Logging
#-[= 5P
[E? Team
#[= Test
®- (= Web
[E? Web services
== Other

. ..... I'-l-E FTP

e

@ = Back Einish Cancel

6. From the Import Project Interchange Contents page, click Browse and select the
ClipsAndTacksF1.zip exported from WebSphere Business Modeler.
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& Import Project Interchange Contents

Import Projects (=

Import Projects from a zip file. I |
= d

From zip file: C:\ClipsandTacks\ClipsAndTacksF 1.zip M [Eruwse. = ]

Project location root: | C:\Documents and Settings\Administrator \IBMYwida, 1'dc
=ClipsAndTacksF1:

[Select.ﬁ.]l] [Deselect.ﬁ.ll Select Referenc

':?:' Mext = Einizh l [ Cancel

7. Select ClipsAndTacksF1 and click Finish.

WebSphere Integration Developer should be displaying the Business Integration

perspective:
A= X

ﬁ | E‘@ Business Inte... |
 [55 Business Integration

.

7| B Business Monitoring

Other...

To change to the Business Integration perspective, click the Open Perspective icon
[ and choose Business Integration.

Before continuing, wait for Building Workspace to complete. (The status is located
in the bottom right-hand corner of the workspace.)

Note: The ClipsAndTacksF1 project will have some errors at this stage of the
sample.

Business process and business rules development

The artifacts from WebSphere Business Modeler must be converted into an artifact
that you can deploy to the server by using WebSphere Integration Developer.
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To define business rules, complete the following steps:

1. In the project tree, expand ClipsAndTacksF1 and select Business Logic » Rule
Logic » processes\orderhandlingfuturel.

2 Business Integr... &% . Physical Resodr... | =0
o

B BeEd 5%
= B_—,,-E ClipsAndTacksF 1
#-55) Assembly Diagram

----- @E Dependencies
=g Business Logic
- Processes
---EE Rule Groups
Elf Rule Logic
Elﬁ processes \orderhandlingfuture 1

E_EI--- £ Data Types
---@ Interfaces
- Mapping

2. Double-click AutomaticApprovalF1. The business rule set editor opens.

3. Click the Add Action Rule icon é‘% under Rules.

~Variables &= K
Mame Type
*Rules @ @]ﬂ o XK
a
Edd Action RuIEL
*Templates E % b 4

4. To copy the input variable to the output variable, click Action and select
Output:Order. Then select = and then Input:Order.

~Rules @ é?}: ,ﬂ @ ®

Mame Rulel

Presentation
Action

*Templates | i Call a method

- @ Input : Order -
[+ @ Qutput : Order

F3 [ (2] Create BO g

p
Build Activities | Propy I:-If.] Copy BO

| MName | Ten

Server
= | <:.'§' return
WebSphere

B8 WebSphere

3-42  IBM WebSphere Clips and Tacks: Getting started with the IBM BPM suite of products



5. Add a second rule by clicking the Add Template rule icon 41 and select

AutoApprovalTemplate.

~Rules = il oE
E % E AutoApprovalTemplate
MName Rulel
Presentation |
Action Qutput = Input

6. Click Enter value and type 750.00.

~Rules RS X
Mame Rule1
Presentation
Action Qutput = Input
MName Rule2
Template AutoApprovalTemplate
a P tati If Check Order Handling Policy for Automatic Approval. Input. TotalPrice is less than or equal to | Eater Value|,
TESENLATON | then Check Order Handling Policy for Automatic Approval. Output. OrderProcessingPreference. automaticApproval is set to True

7. Save your work.

All errors have been resolved. The following image shows the completed rule

logic.
= AutohpprovalF1 22 =5
~Rule Set =]
| Name | AutoApprovalF 1 | | Display Name AutoApprovalF 1 |
~Interface
(D Interface CheckOrderHandlinaPolicyfor AutomaticAppraval
{i} Operation InputCriterion
1 Input Input Order
[ Output Output Order
~Variables & &
| Name ‘ Type |
~Rules EaERe R
Name Rule1
Presentation
Action Output = Input
Name Rule2
Template AutoApprovalTemplate
5 tati If Check Order Handling Policy for Automatic Approval.Input.TotalPrice is less than or equal to[750.0],
TESENTANON | 4hen Check Order Handling Policy for Automatic Approval, Output.OrderProcessingPreference. automaticApproval is set to True
~Templates LR
Name AutoApprovalTemplate
5 tatior | If Check Order Handing Policy for Automatic Approval. Input. TotalPrice is less than or equal to ‘totaiPriceMax ;
PESENIENEN | then Check Order Handling Policy for Automatic Approval, Output. OrderProcessingPreference. al icApproval is set to True
Description | <Type the description here. »
MName Type Constraint Description o
Parameters
totalPriceMax double Mone maximum purchase for automatic approval
If Input.TotalPrice <= totalPriceMax
Then Output.OrderProcessingPreference. automaticApproval = true

Remove export from the assembly diagram

Because this process is intended to be launched through the Order form, not
through a Web service call, remove the export element from the assembly diagram
by completing the following steps:
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1. In the Business Integration view, expand the assembly diagram from the project
tree and double-click processes/orderhandlingfuturel/OrderHandlingFuturel.
The assembly diagram editor opens.

2. Every element in the assembly diagram is selected when the assembly diagram
is launched. Click on the white space to deselect the elements. Export is the
leftmost element in the diagram. Right-click the export element named
OrderHandling (Futurel), and, ensuring that you have selected only the export
and not all of the elements in the diagram, select Delete. You do not need the
export because you will add a human task to invoke the business process later.

(@ There are & new elements that have been added to your module. 2

(1) E CheckOrderHandingPolicyfor AutomaticApproval

Check Order Handling Policy for Automatic Approval

% Gﬂ‘. CheckCustomerAccountStatus

o
O Lt Check Customer Account Status
* * 1.1
@ ¥ g & ) 2 OrderHandingFuture1
T EweY
aerE ey ateCrderDatabse
OrderHar §> %%Upd teOrderDatab:
Add Interface OrderHandiing (Future1) Update Order Databse
Generate Binding. .. L
Refactor 4 % Gé. CancelOrderandSendNotification
|| Copy Cancel Order and Send Motification
3 Delete

Rename
Select All

3. Save your work.

Create the process invocation method
Create the process invocation method by completing the following steps:

1. In Business Integration view, expand ClipsAndTacksF1 > Business Logic »
Processes » processes\orderhandlingfuturel and double-click
OrderHandlingFuturel. The process OrderHandling (Futurel) opens.
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“I] OrderHandlingFuture1_Flow I

| & Check Order Handling Policy for Automatic Approval ]

O
S S
l & Check Customer Account Status | <Q
O
i
¢ [ @ Review Order |
O [ n
- o - et \"
l f% Ship Order to Customer ] l é Cancel Order and Send Motification ]

[ & Update :der Databse J

—l
=T

2. Click OrderHandling (Futurel)Receive. Select the Properties tab and then
select Authorization.

Build Activities | = Properties 3 Problems|5ervers‘ = =08

Description [ @ | Receive - OrderHandling (Futurel)Receive
Details

Potential starters of the process may be specified using a human task.,
Server Human Task: —Mone — Remove

Authorization

Correlation
Environment
Event Monitor
- Global Event Settings.

3. Click New. The human task wizard opens. Click the + sign under User
Interface and select IBM Lotus Forms client.

~Invocation Task =]

MName | OrderHandlingFuture 1Task1 | | Display Mame <Mot Applicable >
+Service Interface
~People Assignment (Originator) & X

| B Potential Starters | Everybody |

~User Interface k| 1.“ |
| Lty User Interface Portal Client |
Business Process Choreographer Explorer
~Escalation I
]
Running

4. In the Properties view, select the Client Settings tab and click Browse. The
Select a Lotus Form wizard opens.
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5. Expand ClipsAndTacksF1 » processes » order and select Order.xfdl. Click

OK.
N Colect a Lotus Form EI >
Choose a file:
= % ClipsAndTacksF 1
= 4= processes
= order
[ rder
. ok || cance

6. In the human task, click Service Interface, then the OrderHandlingFuturel
interface. The OrderHandlingFuturel interface opens in the interface editor.

7. Change the name of the input from Input to Order, which is required for the
Lotus Forms client, and press Enter. It is important that you press Enter while
in this field.

,SZ *OrderHandlingFuture 1 | Eqr"ﬂ *OrderHandlingFuture ITask1 (@ OrderHandingFuture1 &3 =0

= 0Dperations E-f %_‘§| .P] -5-E> -@l =

COperations and their parameters

| Mame Type

v’églnpuﬁ:riterion
E#1 Inputis) Order Order

8. Save your work and close the Operations view.

9. In the human task view, save your work. The following image shows the
completed task.
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10.

1.

12.

13.

‘Q *OrderHandlingFuture 1 F;‘El OrderHandlingFuture 1Task1 &3

B o

~Invocation Task |

| Name | OrderHandlingFuture 1Task 1 | | Display Name <Mot Applicable = |

Service Interface

®Interface OrderHandlingFuture 1

{;} Operation InputCriterion
| 31 Input | Order Order |
rPeople Assignment (Originator) g 3

| B Potential Starters |Everyb0dy |

»User Interface g M

Lfy User Interface

IEM Lotus Forms dient

~Escalation

i
k-

=

Build Activities | E] Properties 23 Problern5| Servers| ¥ =08
Client Settings t& client type: IBM Lotus Forms client l

Input: /ClipsAndTacksF 1iprocessesforder/Order. xfdl

[ buring execution time, save form when task is created.

Close the human task editor.

Switch to the OrderHandlingFuturel business process diagram by clicking the
OrderHandlingFuturel tab and then clicking OK on the following message:

k|

@ information &

& ) The inputs or outputs of an operation used by this process have changed.

1
Activities which reference the operation have been updated.

In the process diagram, click OrderHandling (Futurel)Receive.

In the Properties view, click the Details tab and then click D near the input
variable.
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| Receive - OrderHandling (Futurel)Receive

Partner: = brderHandlingFuture 1Parmer

Interface: * OrderHandlingFuture1
Operation:* InputCriterion [v]

Use Data Type Variables

Mame | Variable
|E>ZI Input(s) | Crder | (none)

14. Select OrderVariable and then click OK. (none) will be replaced with
OrderVariable.

15. Save your work. You should no longer have errors.

Generate Java components

1. Click the ClicksAndTacksF1 — Assembly diagram tab. Then right-click
CheckCustomerAccountStatus and select Generate Implementation ~ Java.

(D) E= CheckorderHandingPolicyforAutomaticAppraval

Check Order Handling Policy for Automatic Approval

1 -
(% P.J_'l. CheckCustomer AccgrstSiatn

1.1 - <) Undo Layout Contents

1.1
@ 2 OrderHandlingFuture1
1.1

Add L4
1.1 (% L_"‘H_'L. UpdateOrderDatabs Change Type... N
OrderHandling (Future 1) Update Order Databse) Convert to Import
Generate Export... 4
Generate Implementation... ¥ 43 Human Task
(% PH_'LI CancelOrderandsen Select Implementation. .. 3 P&’: Java
Cancel Order and Send ‘Q. Process

Synchronize Interfaces and References. ..
Refactor
Merge Components

3
. E= Rule Group
- State Machine

|32 Copy

2. Keep the defaults and click OK. CheckCustomerAccountStatusImpl.java opens.
3. Replace the contents of the following method:

public DataObject InputCriterion(DataObject input) {
//T0D0 Needs to be implemented.
return null;

}
with the following content:

public DataObject InputCriterion(DataObject input) {
System.out.printin(
"Check Customer Account Status Invoked");
// create CreditRating bean
com.clipstacks.credit.CreditRating creditRating =
new com.clipstacks.credit.CreditRating();
// call CreditRating bean to update the BO
DataObject orderOut = creditRating.calculateCreditRating(input);
return orderQut;

}

4. Save your work. Ignore the errors at this time because they will be fixed after
you create the Java components in the steps to follow.
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5. To create the other two Java components, complete the previous steps to
generate Java implementations for the following components and then replace
the following methods.

a. For UpdateOrderDatabase, replace the contents of the following method:

public DataObject InputCriterion(DataObject input) {
//TODO Needs to be implemented.
return null;

}
with the following content:

public DataObject InputCriterion(DataObject input) {
System.out.printin("Update Order Database invoked");
return input;

}

b. For CancelOrderandSendNotification, generating the Java component
builds the text part of the Notification business object. Replace the contents
of the Java file with this content and then save the changes:

package sca.component.java.impl;

import commonj.sdo.DataObject;

import com.ibm.websphere.sca.ServiceManager;
import java.math.BigDecimal;

import java.util.List;

public class CancelOrderandSendNotificationImpl {
[ **

* Default constructor.

*

/
private com.ibm.websphere.sca.ServiceManager serviceManager = null;
private com.ibm.websphere.bo.BOFactory boFactory = null;
String namespace = "http://ClipsAndTacksF1/Businessitems";
public CancelOrderandSendNotificationImpl() {

super()

serviceManager = new com.ibm.websphere.sca.ServiceManager();

boFactory = (com.ibm.websphere.bo.BOFactory)serviceManager

.locateService("com/ibm/websphere/bo/BOFactory");

}
[x*

* Return a reference to the component service instance for this implementation
* class. This method should be used when passing this service to a partner
reference
* or if you want to invoke this component service asynchronously.
*
% @generated (com.ibm.wbit.java)
*/
private Object getMyService() {
return (Object) ServiceManager.INSTANCE.locateService("self");
}

[x*
* Method generated to support implemention of operation "InputCriterion" defined
for WSDL port type
* named "CancelOrderandSendNotification".
*
* The presence of commonj.sdo.DataObject as the return type and/or as a parameter
* type conveys that its a complex type.
Please refer to the WSDL Definition for more information
* on the type of input, output and fault(s).
*
/
public DataObject InputCriterion(DataObject Input) {
System.out.printin("Cancel order invoked");
// retrieve customer e-mail address
DataObject customer = Input.getDataObject("Customer");
String emailAddress = customer.getString("Email");
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// create e-mail text

String textl = "Shipment for order: " + Input.getInt("OrderNumber") + "\n";
String text2 = "Dear " + customer.getString("ContactFirstName") + " " + customer
.getString("ContactLastName") + "\n";

String text3 = "We are sorry that your order was cancelled.\n";

String text4 = "The amount of $" + Input.getDouble("TotalPrice") + " was too
much at this time\n";

String text5 = "We hope to serve you again in the future.\n";

List orderitems = Input.getList("OrderItems");

int nrofitems = orderitems.size();

System.out.printin("orderitems.size = " + nrofitems);

String itemtext[] = new String[nrofitems];

String text6 = "";

String fortyBlanks = " "s //need this to ensure the product

name has at Teast 40 chars
for (int i=0; i<nrofitems; i++) {
DataObject item = (DataObject)orderitems.get(i);
String productName = (item.getString("ProductName") + fortyBlanks)
.substring (0, 40);
itemtext[i] = item.getInt("Quantity") + " " + item.
getString("ProductNumber") + " " + productName + " $" + new
BigDecimal (item.getDouble("Price"));
text6 = text6 + itemtext[i] + "\n";

1
String emailText = "\n" + textl + text2 + text3 + textd + texth + text6;

// build notification data object

DataObject notification = boFactory.create(namespace, "Notification");
notification.setString("email", emailAddress);
notification.setString("text", emailText);

System.out.printin("Cancel order email address: " + emailAddress);
System.out.printin("Cancel order email text: " + emailText);

return notification;

}
}

Important: If you cut and paste this content into the Java editor, ensure that
the variable fortyBlanks does not get compressed down to a single blank. It
must be 40 blanks (spaces) for the code to work correctly.

6. Save your work and close the window.

Provide the implementation for calculating customer credit

ratings

1. Create a Java package by selecting File » New » Other and then Java -
Package. Then click Next >.

2. For the source folder, click Browse and select ClipsAndTacksF1 » gen/src. Click
OK.

3. For the Java package name, enter com.clipstacks.credit and then click Finish.
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CE New Java Package

Java Package
Create a Java package.

Creates folders corresponding to packages.

Source folder: | ClipsandTacksF 1/gen/src | [ Browse... ]
Mame: | com.dipstacks. credit |
@ Mext = [ Finish ] [ Cancel

Switch to the Physical Resources view by clicking the Physical Resources tab

(where the Business Integration tab is).

Expand ClipsAndTacksF1 » com > clipstacks > credit and copy the
CreditRating.java file that you downloaded following the directions in the
Download section. Then paste the file into the credit folder.

=52 ClipsAndTacksF1
# (2 businessitems
IEE- businessserviceobjects
ElIE? com
. 5= dipstacks
= aedit

o CreditRating.dass

: - m CreditRating.java
[*[= processes

Switch back to the assembly diagram editor and save it.

Save any unsaved items. An open window with an asterisk (*) on the tab
indicates that it is not saved. You should not have errors now. If there are
errors, fix them before generating the user interface.

Rebuild all projects by selecting Project » Clean and then OK.

Project Data Run  Window Help

1 )
o T
=]

= =1
m o

Build Working Set r
Clean...
W Build Automatically

Business Integration Projects 3

Carvert fooa Divrammie =

Ry &
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Important: Ensure that the Building workspace action is completed before you
generate the user interface. When building is complete, you will not see the
following sign percent and status bar indicators. If the icon clears quickly, it is
best to wait approximately one minute to be sure all build activity has

completed.

. Building workspace: (S6%) o=

Generate the user interface for the business process

Because Lotus Forms is used in the business process, you will generate a Lotus
Forms UI client for the process. It is possible to generate separate clients with
different URLs for each human task in the process, however in this tutorial you
will generate one client for all human tasks. In a production environment, access is
typically based on roles and only authorized users can access specific tasks. For
simplicity, all roles can access the human tasks in this tutorial.

Generate the Lotus Forms client for the process by completing the following steps:

1. Switch to the Business Integration view.

2. Right-click on ClipsAndTacksF1 and select Generate User Interfaces.
3. Select IBM Lotus Forms client as the Generator type and click Next.

e User Interface Wizard for Human Tasks

)

Client Generator Selection
Select a generator type and human tasks to generate & user interface. "
=

\

Human Task(s)

Generator type |IH\| Lotus Forms dient

(]

= [v] ClipsAndTacksF 1

[=)-[+] Processes
= [v] OrderHandlingFuture 1

= [w] Invocation

OrderHandlingFuture 1_InputCriterion

= [#] To-do

ShipOrdertoCustomer_InputCriterion
ReviewOrder_InputCriterion

Select All

Cancel

4. Name the dynamic Web project C1ipsAndTacksUI. For Style, select IBM Style
and click Finish.
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@ User Interface Wizard for Human Tasks

IBM Lotus Forms client configuration

Spedfy destination project, company logo, dient location and style for your dient.

Mame of dynamic web project: | ClipsAndTackslI
Company logo:

Client location

(+) Generated dient and related processes / tasks reside on the same server. {Local dient view)
(") Generated dient and related processes / tasks reside on different servers. (Remote dient view)
Provider URL: liiop:/fREMOTE_SERVER _IP:BOOTSTRAP_PORT

Style selection

Stle:  |IBMStyle

Preview: I

\£) l < Back ][ Mext = H Finish H Cancel

On the Client generation completed message, click OK.

-,

€D Client generation completed.

—
The Lotus Form dient has been generated to a Web Project called i i
"ClipsAndTacksUI",

How to deploy and launch the dient, select help icon below,

Deploy the Clips and Tacks Order Handling business process

Export the sample to the WebSphere Business Monitor for deploying to the

runtime.
1. Click the Servers tab and then right click WebSphere Business Monitor Server
v6.1 on WebSphere Process Server and click Start.
Build Acﬁvines|Properﬁes|Pmblems (-ﬁé- Servers &0 %0 ge =0
Server Status State
5] WebSphere Business Manitor Server v5. 1 on WebSphere Process Server | Stopped Republish
WebSphere Process Server v6.1 E'@ Stopped Republish
2.

It will take few minutes for the server to start. When the server is started (the

server status will change from Stopped to Started), right-click the started
server and select Add and Remove Projects.
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Monitoring Flow | Properties | Problems r-{iﬂ Servers o4 Console|
Server Status State
%) WebSphere Business Manitor Server v6. 1 an WebSphe i Started ,
WebSphere Process Server va. 1 E'g Stopped New
Open
Delete
.’.“J_: Profile
Restart 4
Stop
ELE publish
Monitoring 4
Maove to Workspace
' Add and Remove Projects...

3. Add both projects by selecting Add All and click Finish (if you have other
projects in the workspace, you can add ClipsAndTacksF1App and
ClipsAndTacksUIEAR individually using Add).

-,

€2 Add and Remove Projects

Maodify the projects that are configured on the server

Add and Remove Projects @
=

Maove projects to the right to configure them on the server

Available projects: Configured projects:

---@ iClipsAndTacksF 1App!
[#- [ ClipsAndTacksIIEAR. [

Add> |

=
i
E
m

Add All ==

m
I

2
il

L) < Badk Mext = uinish ] [ Cancel

4. Wait for publication of the applications to the server to finish.

Test the Clips and Tacks Order Handling business process
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After deploying the application, test the process.
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1.

In an internet browser, enter the URL |http:/ /localhost:9080/Clips AndTacksUI}
The port number, 9080 in this tutorial, depends on the number of server
profiles that are created on your system. Your port number might be different.
If 9080 doesn’t work, open the SystemQOut.log from C:\Program
Files\IBM\WID61\pfAWBMonSrv_wps\logs\serverl and search for
default_host. The port number next to default_host is the port number you
need to use. It is typical for 9080 to the be the first port number used; then the
port numbers increment by 1 for each additional server profile.

Enter admin as user ID and admin as the password; then click Login. (If you
used a different user ID and password combination during the installation,
then you need to use that user ID and password here and throughout this
tutorial wherever the user ID admin is used.)

Login to Business User Client

Enter user name and password, then click Login.

Mame: admin

Fassword: sssss

The following image shows the generated client interface.

/€ setting - Windows Internet Explorer [B=1<]
v | @] h: 19081/C x| [#2]| X | ocgle L~
L

W [@smng [7 i - i v [ eage - EHrock + 7

R =

- HomE Business User Client

> Business Case

-+ New .
~ Business Case

- Status

> Ny ToDo's - New

+ Open Selectthis to view a list of all the tasks that you can use to create a business case. For search criteria, you can provide additional
information.

-+ Claimed

~ Status
Selectihis to view the cuMrent state of  process (for example, whether itis running, of finished). You can ehoose a process from a st
S iSer: i ‘l and then provide search criteria to find a specific instance.

-+ Logout

~ My ToDo's

en
Selectthis to claim ataskfrom a list ofthose that have been started

+ Claimed
Selectthis to see a list of the tasks that have already been started and claimed. You can then complete a task by choosing it and
inserting the necessary output data

Done % Local intranet  100%

Under Business Case, click New and then select
OrderHandlingFuturel_InputCriterion. The Order Lotus form is displayed.

* For this scenario, when you enter the data, the TotalPrice should be greater
than $750.00 to force the process to flow to the Review task. You may copy
the data elements as they are in the image below.

* Do not enter text below the red text that reads Below this line is for Clips
and Tacks office use only.
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* You can add a new row to the ordered products table by clicking the + sign;
similarly, you can delete a row by clicking the — sign. You can order multiple
items, but ensure there is only one item per row.

* When you have completed the form, click Create at the top of the form to
create a running instance of the process.

€ Setting - Windows Internet Explorer BEx]
(<1585 4] (%] (] [cosce | 2B
W Igsemng HE @ - [ page - GFTooks -

—

- Home Business Cases > New > OrderHandlingFuture1 > OrderHandlingFuture1_InputCriterion

> Business Case

Enter the values for the input data andior provide additional infarmation to create your task.
- New

+ Status 2R SEBETT LE o[Me|Ve @
> My ToDo's Create

%1 \)Clips&Tocks

Customer Number [1
Company Name [BM
Contact FirstName [John
Contact Last Name [Doe
Street Address [100 Main Street
city [NewYork

Country ,USA—

Postal Code [t0004

Email [johnDoe@ibm.com

Rating ,100—

Available Credit [so0
Order Number l101—

‘ Product Name ‘Prodncl Number ‘Description ‘Prioe |Q||anlity ‘Ilem Price ‘

+ Claimed

[ s I

‘ + Logout |

: lpen lpen-1 llexpensive pen |10 loo I s1,mm\ﬂ]ﬂ v
< m

Done &4 Local intranet # 100% v

4. Under My ToDo’s, click Open. The process instance is waiting for the
ReviewOrder task to approve the order as shown in the following figure (see
the note following the figure if you do not see the task)

Setting - Windows Internet Explorer
%ﬂ - |g, http:/localhost: 905 1/ClipsAndTacksUl ffaces/Setting jsp M‘EHE' ‘C':‘:‘SE “}J 'l
W [@Semng I I [N = - [i;FPage ~ () Tools ~ .

My ToDo's > Open

Select a task to see more details and finally claim the task

-+ New

+ Stafus Task Hame © Description ©  FirstActivated ¥ Originator

» My ToDo's + OrderHandlingFuture150rderHandlingFuture 1_ReviewOrder 121807 2:33:36 PM admin
~ Open lterns found: 1 Page 10f1 E ltems per page:

-+ Claimed
—
-+ Logout

<] m | B

% Local intranet = 100% -

Note: If you do not see the task in the ToDo list, check the Console tab in
WebSphere Integration Developer to see if there is a NullPointerException in
the execution of the CreditRating.java file. If so, this is due to an infrequently
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occurring bug in WebSphere Integration Developer. The easiest way to recover
is to start over with a new WebSphere Integration Developer workspace. Below
is the recovery procedure:

a. Close the browser window showing the ToDo list.
b. In WebSphere Integration Developer, select the Servers tab.

c. Right mouse on WebSphere Business Monitor Server v6.1 on WebSphere
Process Server and click Add and Remove Projects.

Remove ClipsAndTacksF1App and ClipsAndTacksUIEAR from the server.
Right mouse on WebSphere Business Monitor Server v6.1 on WebSphere
process Server and click Stop
f. Exit WebSphere Integration Developer, but before exiting, write down the
workspace path displayed in the WebSphere Integration Developer title bar.
g. Using Windows File Explorer, delete the workspace you noted above.

h. Restart WebSphere Integration Developer with a new workspace. You may
reuse the directory name used previously, but you must first have deleted it
from the file systems so that WebSphere Integration Developer creates the
workspace anew.

i. Repeat the Build It Yourself steps above starting with the import into
WebSphere Integration Developer.

Click the waiting task and then under the form click Claim to work on the
task.

/€ Setting - Windows Internet Explorer
Q- &

* & [@setng

BE)X]
oL

RG)x) [

B - B - [rPage v GiToos +

|

+ HOME

My ToDo's > Open > OrderHandlingFuture1$OrderHandlingF uture1_ReviewOrder

> Business Case

Enter the values for the output data of your task
-+ New

-+ Status BEE S8 EH ZHelwMe Ve d
> HyToDo's Release| Save| Complete|

- Open
- Claimed

ContactLastName [Doe
Street Address [100 Main Street
city NewYork

Gountry [UsA

 Logon |

Postal Code (10004

Email [johnDoe@ibm.com
Rating oo
Available Credit [S000
Order Number [t04

Product Name [Product Number | Description Price Eamiw

Item Price

[st00000 | 2]

[mechanical pen [[5.0 [150 $§750.00

Total Price $1,750.00
-------------- Below this line is for Clips and Tacks office use only -~
Order Status [APPROVED v
Packing Slip Number

[pen pen-1 [expensive pen - ([10.0 00

[pencil lpencil-1

v

e [ oo <

At the bottom of the form, select the Order Status drop-down list and select
APPROVED. Complete this human task by clicking Complete (located at the
top left corner of the form).

Note: Save does not complete the human task, but saves the task so that you
can return to it. Click Complete so that the process will continue to the next
task.

Click Refresh in the client (not the browser Refresh). Now the process is
waiting for someone to claim and work on the ShipOrdertoCustomer human
task.
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/€ Setting - Windows Internet Explorer mE=|
G_.g/) ~ [ Ie] http: flocahost:3081/CipsAndTackeU faces Setting.jsp ] [##[3¢] [so0cie [[2]]
w I@sm‘ng Iil - v [hpage - (FTook <

* Howe My ToDo's > Open

Select a task to see more details and finally claim the task.

-+ Mew

- Stalus Task Name ¥ Descripion ©  FirstActivated ©  Originator ~

> My ToDo's =+ OrderHandlingFuture 150rderHandlingFuture1_ShipOrdertoCustomer 12/18i07 2:39:20 PM  admin
Open
- e Items found: 1 Page 1 0of 1 EI Items per page:

+ Claimed
-+ Logout
fv)
Done % Local intranet #100% -

8. Click the waiting task and then click on Claim to work on it.

9. Enter a Packaging Slip number and click Complete to complete the business

process.
& setting - Windows Internet Explorer [=1%]
G‘.@, ~ [Elw 1 [3] (42 [x] [sooge 28
& snaalt
w [gsmm ]7| L - e - sk - @
+ HOME =
My ToDo's > Open > OrderHandlingFuture1$OrderHandlingFuture1_ShipOrdertoCustomer
? Business Case ‘ Enter the values for the output data of your task.
+ New
+ Status EEEIEEE £ oo Ve @
|
> My Tobo's | |Retease| 'Save| Gomplete|
- Open Contact Last Name [Doe =
- Claimed Street Address |1DD Main Street
City [New York
> User: admin w Country [U5A
-+ Logout
Postal Code [10004
Email |inhnDnE@ibm.cnm i
Rating [100 | |
Available Credit [500.0 |
Order Number [101
Product Name |Product Number | Description Price Quantity Item Price
[pen pen-1 [expensive pen [10.0 100 $1,000.00 ﬂ J
[pencil pencil-1 [mechanical pen |[5.0 [150 $750.00
Total Price | §1,750.00
Below this line is for Clips and Tacks office use only
Order Status | APPROVED | v
Packing Slip Number 10005
[~}
< I | B @
Done AJ Local intranet 100%
L] S

You have just executed one process instance of the Clips and Tacks OrderHandling
(Futurel) business process. Because the total price of the order was more than
$750.00 and the available credit was less than the total price, the order went to the
ReviewOrder human task (either of the conditions would have sent it to review).
The ReviewOrder human task approved the order and it went to the
ShipOrdertoCustomer human task. The ShipOrdertoCustomer human task gave a
packaging slip number and sent the order to the customer.
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Monitor the business process

Because the project is rebuilt and redeployed to the server every time that you
save a change, which will slow down your monitor model creation, use Add or
Remove Projects to remove both of the projects from the server.

In the Business Integration view, click the Servers tab.

2. Right click WebSphere Business Monitor v6.1 on WebSphere Process Server
and select Add or Remove Projects.

|Build Activities | Properties | Problems ﬁ?& Servers i Console |

Server Status State
W&&iﬂe&ﬁmﬂwihﬂawv&lmwmeﬁmm E‘p Started Synchronized
WebSphere Process Server va, 1 E‘@ Stopped Republish

3. Click Remove All (if you have other projects, use Remove) and click Finish.

Wait for WebSphere Integration Developer to remove the projects.

€D Add and Remove Projects
Add and Remove Projects
Maodify the projects that are configured on the server
-—J

Maove projects to the right to configure them on the server
Available projects: Configured projects:

l% ClipsAndTacksF 1App
(5 ClipsAndTacksUIEAR

<< Remove All

2 = Back ext = [ Einish H Cancel

4. From the Business Integration pane, select ClipsAndTacksUI and

ClipsAndTacksUIEAR. Right-click and select Delete. this to work around a
problem; when the base project changes, ClipsAndTacksF1 in this case, you
have to regenerate the user interface and redeploy.
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5] ClipsAndTacksF 1
- ClipsAndTacksUI
B ClipsAndTacksUl

...................................... Mew 3

f':d dipsbpmModelLg Copy Cirl+C
qu dipsbpmMaodera

H Delete Delete
Build Path »
Source Alt+5hift+5 ¥

5. Select Also delete contents in the file system. You will regenerate the user
interface later.

&2 Confirm Multiple Project Delete

9
\._‘:/‘
(3)iplzo delete contents in the file system:
() Do not delete contents

Are you sure you want to delete these 2 projects?

Update the business process to emit monitor events

Before you create the monitor model, you must select the events that WebSphere
Process Server will generate. WebSphere Business Monitor will use the generated
events to monitor the process. Events need to emitted for decisions and invocation
actions in the process. The process representation in WebSphere Integration
Developer is BPEL. WebSphere Business Modeler decisions become BPEL links in
WebSphere Integration Developer. You need to configure to emit events for the
parallel activity BPEL element (OrderHandlingFuturel_Flow) to emit events for the
links.

The business object date (order form data) can be accessed from several events
including SCA ENTRY events, receive activity (EXIT) events, or invoke activity
(ENTRY) events. You could use the SCA events, but then the auto-generated
monitor model would not have a trigger to terminate monitoring that process
instance; thus, this option requires you to add the termination trigger. You could
also use the receive activity EXIT event. In this tutorial you will use the first
invoke activity (ENTRY) in the process to access the order form data.

1. In the Business Integration view, select ClipsAndTacksF1 » Business Logic »
Processes » processes\orderhandlingfuturel and then double-click
OrderHandlingFuturel to open the BPEL editor.

2. Click the white background of the process. Ensure that you click outside of the
parallel activity (OrderHandlingFuturel_Flow) element, which is the large
rectangle that contains elements such as receive, human tasks, and invoke
elements.

3. Click the Properties tab under the BPEL diagram, and then click the Event
Monitor tab (if you have to scroll down, you must scroll from the left side, not
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the right side). For a production application, you would want to select the
individual events to emit, but for simplicity in this tutorial, select All.

Description

Details

= T
Build Actvities | ) Propertes £7 . Problems | Servers | Cnnsnle‘

- = |

f £ Process - OrderHandling (Futurel)

| Event Moritor
- Global Event Settings

e \ Destination cal auditLog

Administration | Monitor | Event Content [ on Transaction | Label
Java Imports O None

Join Behavior

Imparts Du [Fur [ [Existing [v]

Environment O selected

4. Click inside the OrderHandlingFuturel_Flow parallel activity element, and

then click All on the Event Monitor tab.

5. Similarly, select All events for each of the four invoke activities and the two
human tasks. You will select each of these activities in the BPEL diagram and
then update the Event Monitor tab. Update the following activities to emit All

events:

* Check Order Handling Policy for Automatic Approval
* Check Customer Account Status

* Review Order

* Ship Order to Customer

* Cancel Order and Send Notification

* Update Order Database

6. Save your work. Review each of the four invoke activities, the two human
tasks, the flow, and the process to ensure the Event Monitor is set to All.
Events that are not being emitted can be difficult to detect and debug.

The following screen capture shows the yellow flag icons that indicate the events
that are selected to be emitted for the components. There are flags on each of the
six activities. The flag in the upper left is for the flow. The flag in the upper right

is for the process. There are eight flags in total.

2 OrderHandlingFuturel &2 \'?31 ClipsAndTacksF 1 - Assembly Diagram |

=.E|'

= 6

i@ Basic Actions

<9 Invoke ¥ |£| OrderHandiingFuture1_Flow

= Assign El )

@ Receive

@ Receive Choice E| OrderHandling {(Future 1)Receive
<0 Reply 4

® Wait - ?<? Check Order Handling Policy for Automatic Approval
(2 Structures | \'/—O—
_@_-50.?—. 'P'@ Check Customer Account Status

| X | Parallel Activities V)

= Sequence ‘P,-%'Q Review Order

2 Choice ' O l O 2
) Whil Loop .P.%‘Q Ship Order to Customer .P;? Cancel Order and Send Motification
£4 ForEach ] 7

- L' LﬁJ E

(¥ Faults P@ Update Order Latabse

@ Compensate

1<% Throw 28

[ 3 Rethrow @

Terminate |<_| i

HF £ orderHandiing (...
fip Interface Parners 4 3%
¥ OrderHandlingFuture 1P
& Reference Partners & %
b CheckOrderHandlingPol
¥ CheckCustomerAccount
¥ UpdateOrderDatabsePz
b CancelOrderandSendie

@ Variables 5 3%
OrderVariable
MNotificationVariable

& Correlation Sets & %

[@ Correlation Proper... 5" %
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Create the monitor model to monitor the business process

You use a wizard to auto-generate the monitor model from the process. You will
then have two monitor models, the business measures model from the process in
WebSphere Business Modeler (the high-level model) and the monitor model
generated from the process in WebSphere Integration Developer (the low-level
model). The high-level model contains the monitor elements that need to be
implemented in the final monitor model. The low-level model contains the
monitoring context instance creation, termination, and correlation information
based on the events generated from WebSphere Process Server.

You have three options when using these two monitor models:

* Keep both models intact and create outbound events from the low-level model
to feed metric information to the high-level model. This options supports
product synchronization for both models to easily handle changes that are made
to the process or changes that are made to the business measures model.
However, this option also requires extra work to build the event definitions and
the monitor elements that support it.

* Keep the high-level model intact and add inbound events to the high-level
model using New > Create from Application in WebSphere Integration
Developer, and then copying the generated artifacts into the monitoring context
for the high-level model. This option is easy and can be useful when the
low-level application is stable, but the business measure requirements are
churning. However, this option does not support synchronization with the
process application.

* Keep the low-level model intact and then copying business measures
information into the low-level model from the high-level model. This option is
the easiest and can be useful when the low-level application is churning, but the
business measure requirements are stable. However, this option does not support
synchronization with business measures from WebSphere Business Modeler.

For this tutorial, you will use option three. Therefore, you need to merge the two
models into one monitor model. Then you will add the implementation details for
the KPIs and other monitor elements.

1. Generate the monitor model in WebSphere Integration Developer from the
BPEL process by completing the following steps:

a. In the Business Integration view, right-click ClipsAndTacksF1 and select
Monitor Tools » Generate Monitor Model.
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(1 Business Integr...

el Physical Resour, .. |

=T

= #ed B

= B
& ¥

?:d Clipsand]
w32 Clipsand

#-5=! ClipsAndT -

Mew

Cpen Assembly Diagram
Open Deployment Editor
Open Dependencies
Show Files

|i=| Copy
¥ Delete
Refactor

E2q Import. ..
L Export...

£ | Refresh
Close Project

Synchronize with Modeler Export. ..

L} Generate User Interfaces..

Validate

=i Generate Documentation. ..

Team
Compare With
Test

Manitor Tools

v v v v

Generate Monitor Model

Properties

For the Target monitor project, enter clips.
Click New Project, then click Finish.

For the Target monitor model name, enter clipsbpm and click Next.

ol

E Generate Monitor Model

&

Generate monitor model

Specify the target location and model name for the new monitor model,

EH g

Target monitor project:

| dlips

M| [New Project... ]

Target monitor model name: | dipsbpm

@

< Back

1m

Finich

Cancel

In the Generate Monitor Model dialog box, in the Choose what to monitor
section, navigate the Event Source field to ClipsAndTacksF1 -
ClipsAndTacksF1Module » Order Handling (Future 1) and select Order
Handling (Future 1) as follows:
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Ewvent Source
= 1= ClipsAndTacksF1
= ?cc;l ClipsaAndTacksF 1Module
= .Q, OrderHandling (Future1)
=l 2 iOrderHanding (Future1)
|Z£| OrderHandlingFuture1_Flow
@ MNotificationvariable

f. On the Monitoring Templates tab, click Select All. The generated monitor

model will contain monitoring elements that track all of the listed process
characteristics. One of these characteristics is the Average Elapsed Duration,

which will satisfy the requirement in the business measures model to track
the average processing time.

{2 Generate Monitor Model

Choose what to monitor

Click each of the application elements that you want to monitor. Choose the monitoring templates or events to enable for that element.

ad
Event Source Monitoring Templates | Emitted Events
= 17 ClipsAndTacksF1 Select the monitoring templates to apply to the
=5 ClipsAndTacksF1Module selected element.
Monitoring Template Name
E Elapsed Duration
E- Check Order Handling Policy for Automatic Approval 3 working Duration
(5 Cancel Order and Send Notification i start Time
3 Check Customer Account Status i End Time
%’. Update Order Databse i state

b Average Elapsed Duration - KPI
# Average Elapsed Duration - Measure
ﬁ Average Working Duration - KP1
ﬁ Average Working Duration - Measure

Select All | | Clear

Description of selected template
Select 2 template fo see the descripfion.

[ Limit my selection of events and templates based on
the events that have been turned onin the

application
@

g. In Event Source, select ClipsAndTacksF1 » ClipsAndTacksF1Module »
Order Handling (Future 1) » Order Handling (Future 1) »
OrderHandlingFuturel_Flow:

Ewvent Source
= = ClipsAndTacksF1
= ?.;%’J ClipsAndTacksF IModule
= .Q, OrderHandling (Future1)
= ,Q, OrderHandling (Future 1)
=% | iorderHandlingFuture1_Flow |
<§ Cancel Order and Send Motification

h. On the Emitted Events tab, click Select All. The generated monitor model
will subscribe to these events. The events are for link traversals. These BPEL
links represent the decision elements from WebSphere Business Modeler.
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The events indicate whether a link was skipped or if it was traversed
because the condition was true or false. Note the event name
OrderHandlingFuturel _FlowCONDTRUE. This will be used heavily in the
monitor model.

e Generate Monitor Model

Choose what to monitor [
Click each of the application elements that you want to manitor. Choose the monitaring templates or events to enable for that element.

1]
Event Source Monitoring Templates | Emitted Events
= = ClipsAndTacksF1 Select the events to monitor from the events that
=25 ClipsAndTacksFiModule are emitted by the selected element. If the event is
=2 OrderHandling (Future1) used in a template, you cannot deselect it.
=] EQ, OrderHandling (Futurel) Emitted Event Name
FL {orderHandlingFuture1_Flow ™ OrderHandlingFuture1_FlowSKIPPED
@ NotificationVariable ™ OrderHandlingFuture1_FlowCONDTRUE
@ OrdervVariable ¥ OrderHandlingFuture1_FlowCONDFALSE

4% OrderHandlingFuture 1. InputCriterion
E= Check Order Handling Policy for Automatic Approval
P.J_lj. Cancel Order and Send Notification

G&. Check Customer Account Status

Gé’. Update Order Databse

[ Limit my selection of events and templates based on
the events that have been turned on in the
application

T G B

@

i. In the business measures model, it was specified to track the processing time
for each task. To implement that, click the Monitoring template for elapsed
duration for each activity. To do this, select Cancel Order and Send
Notification. Then on the Monitoring Templates tab, select Average Elapsed
Duration — Measure.

Event Source Monitoring Templates | Emitted Events
= 1= ClipsAndTacksF1 select the monitoring templates to apply to the selected
= ‘?& ClipsandTacksF1Module element,

=% OrderHandling (Future1)
= EZ OrderHandling (Futurel)
= E OrderHandlingFuturel_Flow

Monitoring Template Name
O 5 Elapsed Duration

¥ Cancel Order and Send Notification O & stert Tme
<9 Chedk Customer Account Status [] & End Time =
<9 Check Order Handling for Automatic Approval | Histate
& Update Order Databse [ & working Duration
@ OrderHandiing (Future 1)Receive [[] % average Elapsed Duration - KP1
42| OrderHandiing (Future 1)Reply £ Average Elapsed Duration - Measure
[T i Average Waorking Duration - KPT [v]

P.j Review Order

/i) Ship Order to Customer

j. Repeat step [1h on page 3-64| for the remaining three invoke activities and the
two human tasks. Do not repeat step [lh on page 3-64 for the receive
element, Order Handling (Future 1)Receive. Click Next.

2. Simplify the monitor model so that there is only one monitoring context. A
monitoring context represents the entity or thing that is to be monitored.
Additionally, simplify the monitor model by creating event groups to organize
the events and provide structure in the monitor model:

a. For each of the invoke activities and the human tasks, change the
implementation to Event group by clicking in the Implementation column
and selecting Event Group from the drop-down list.
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Ewvent Source Implementation
= = ClipsAndTacksF1 -

= '?éﬁ ClipsandTacksF 1iMadule Mone
= % OrderHandling (Future1) Mone

= EZ CrderHandling (Future 1) Maonitoring context
=y OrderHandlingFuture 1_Flow Mane

%’\' Cancel Order and Send Motificatio Event group
%’\' Chedk Customer Account Status  Event group
@ Check Order Handling for Automa Event group

@' Update Crder Databse Event group
B:j Review Crder Event group
B:j Ship Order to Customer Event group [v]

b. Click Next. You can preview the model here.

c. Click Finish. When prompted, click yes to switch to the Business
Monitoring perspective. When prompted, do not launch Getting Started.
The monitor model opens in the monitor model editor.

d. Check the Problems view. If you didn’t emit events that the monitor model
requires, then the Problems view will show warnings to indicate that the
events are missing. If you see these messages, update the monitor event
settings in the module and then synchronize the model with the application
(in the project tree, right-click the model and select Synchronize with
Application).

= & Warnings (17 items)
& The event Check Order Handling Policy For Automatic AppravalEMTRY is nat set to be emitted by the application
& The event Check Order Handling Palicy for Autormatic ApprovalEXIT is nok set ko be emitted by the application
& The event Check Order Handling Palicy for Automatic ApprovalEXPIRED is not set ko be emitted by the application

3. Import the business measures model from WebSphere Business Modeler. Many
errors will result from the following actions, but these will be fixed as you
progress through the steps. To import the business measures model, complete
the following steps:

a. In the project tree, right-click the clips project and select Import > General
> File System. Then click Next.

b. Browse to the location that contains the business measures model
(OrderHandling (Futurel).mm) from WebSphere Business Modeler. Then
select the two .svg files and the monitor model:

j Browse. .. |

ElOrder_Handling_xDD28_Future_1_xDD29_KI‘\'
ElOrder_Handling_xDD28_Future_1_xIIIIII29_M[
E'E Order Handling (Fukure 13.mm

1| | »

Filker Twpes... | Select Al Deselect Al |

Inka Folder: | clips Browse, .. |

c. Ensure that the Into folder is clips and then click Finish. There will be
many errors in the Problems view because the metrics for the business
measures model have not been implemented yet.
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You now have the auto-generated model (clipsbpm.mm) and the business
measures model (Order Handling (Future 1).mm) in your clips project:

E

[ ' Project Explorer ©2 =5

& O

=% dips

EE Event Definitions
= EE Monitor Models

E'u clipsbprm.mm

F. OrderHandling (Future 1).mm
=3 5vG Files

Merge these two monitor models together. There are several options. You could
use the menu options Combine Monitor Models or Compare With > Each
Other. Because the names of the monitoring contexts, KPI contexts, and cubes
are different in the two models, using the merge tools will result in a monitor
model that is a union of the two monitoring contexts, two KPI contexts, and
two cubes. The merge options work better if both models start from a common
base so that these containers have the same name. In our example, it is easier
to copy the monitor elements functions from one model to the other.

a.

b.

Open the editor for both monitor models, clipsbpm.mm and Order
Handling (Future 1).mm, by double-clicking each of them in the project tree.

Start Copying elements from the Order Handling (Futurel) to clipsbpm.
Click the Monitor Details Model tab for Order Handling (Futurel). Select
the six percentage metrics (Acceptable Credit Risk? No Percentage,
Acceptable Credit Risk? Yes Percentage, Account in Good Standing? No
Percentage, Account in Good Standing? Yes Percentage, Approve Without
Review? No Percentage, and Approve Without Review? Yes Percentage),
right-click, and select Copy.

Note: There are several additional metrics in the details model for Order
Handling. These are for processing time, but you will not need them
because they were created automatically in clipsbpm when you selected the
duration monitoring templates in the generation wizard.

Monitor Details Model

E'E OrderHandling (Future1) ¥ Metric Details

= &,El OrderHandling (Future 1) MC Edit the details of
i iAcceptable Credit Risk? No Percenta .
i Acceptable Credit Risk? Yes Percentz 1D: alt
[ Account in Good Standing? Mo Percel
i1 Account in Good Standing? Yes Perce Mame: F
i Approve Without Review? No Percer
I Approve Without Review? Yes Pe
il Cancel Order and Send Notificati
i Check Customer Account Status
i Check Order Handling Policy for £
i OrderHandling (Future1) Process
[ Reeview Order Processing Time
[ Ship Order to Customer Processin
[ Update Order Database Processi|

Descriotion:
Filter ¢

Delete

L XBE
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Click the Monitor Details Model tab in clipsbpm, and then right-click
Order Handling (Future 1) and paste the metrics that you copied.

d. Save your work. You will have errors for the pasted metrics.

e. Click the KPI Model tab for Order Handling (Futurel). Select all of the
elements: the two KPIs and the two triggers. Right-click and select Copy.

KPI Model

= EE C_]_rderHandIing (Future1)
== OrderHandiing (Future 1) KC

[“r:‘l Paste

f. Click the KPI Model tab in clipsbpm, and then right-click Template KPI
Context and paste the elements that you copied.

g. Save your work.

h. Click the Dimensional Model tab for Order Handling (Futurel). Select all
of the elements, except for the seven measures with names that end with

_Processing_Time (these measures are already in the clipsbpm model).
Right-click and select Copy.

Dimensional Model

= E’E OrderHandling (Future1)
Elﬁ OrderHandling (Future 1) MC Cube
=

=

----- [ Average Cancel Order and Send Motification Process

1 Average Check Customer Account Status Processing
Average Check Order Handling Policy for Automatic s
Average OrderHandling (Future 1) Processing Time
Average Review Order Processing Time

Average Ship Order to Customer Processing Time
Average Update Order Database Processing Time

PEVEVEREEY

R AR

Filter r

=1
=l
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i. Click the Dimensional Model tab in clipsbpm and then right-click Order
Handling (Future 1) Cube and paste the copied elements.

j. Save your work.

5. For the seven processing time measures that you did not copy, you will need to
copy the tracking keys from Order Handling (Futurel) to clipsbpm. WebSphere
Business Modeler needs the tracking keys when you export WebSphere
Business Monitor data back to WebSphere Business Modeler.

a. In the dimensional model of Order Handling (Futurel), click the measure
Average Cancel Order and Send Notification Processing Time. You will
see the tracking key in the editor as in the following screen capture.

(71 ‘Average Cancel Order and Send Notification|
[ Average Check Customer Account Status Pr
1 Average Check Order Handling Policy for Au
[ Average OrderHandling (Future 1) Processing
[ Average Review Order Processing Time

[ Average Ship Order to Customer Processing
[ Average Update Order Database Processing|
) Dedlined Order Count Tracking key: BLM-ch 1be 38c55528999F 1dfbee 17122193 BLM-ad2 1530 1d25f5

e Order Connt

Source metric: . Cancel Order and Send Motification Processing Time

Aggregation function: | Average

b. Select the text for the tracking key and then copy it to the corresponding
measure of the dimensional model in clipsbpm: Cancel Order and Send
Notification Average Elapsed Duration.

C. Repeat step @lfor the following six processing time measures.

* From Average Check Customer Account Status Processing Time to
Check Customer Account Status Average Elapsed Duration

* From Average Check Order Handling for Automatic Approval
Processing Time to Check Order Handling for Automatic Approval
Average Elapsed Duration

* From Average Order Handling (Future 1) Processing Time to Order
Handling (Future 1) Average Elapsed Duration

* From Average Review Order Processing Time to Review Order Average
Elapsed Duration

* From Average Ship Order to Customer Processing Time to Ship Order
to Customer Average Elapsed Duration

* From Average Update Order Database Processing Time to Update Order
Database Average Elapsed Duration

Note: For Order Handling in clipsbpm there is a working duration measure
and an elapsed duration measure, so update the tracking key for the
elapsed duration only.
6. The diagram view is based on SVG images and shape sets. To create shape sets
in the SVG diagrams, complete the following steps:

a. Click the Visual Model tab in clipsbpm. For Selected Context equal Order
Handling (Future 1), click Browse for SVG File. Navigate to clips and
select Order_Handling x0028_
Future_1_x0029__MDM_Order_Handling x0028_
Future_1_x0029__MC.svg and click OK. When prompted, choose to create
shape sets.

b. Change the Selected Context to Template KPI Context and then click
Browse to select an SVG file for this context. Navigate to clips and select
Order_Handling x0028_ Future_1_x0029__KM_Order_Handling_ x0028_
Future_1_x0029__KC.svg; click OK. When prompted, choose to create shape
sets.

c. Save your work.
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d. Close the Order Handling monitor model because you have copied
everything you needed from this model to clipsbpm.

e. To remove the numerous errors that are associated with this model in the
Problems view, right-click OrderHandling (Futurel) in the project tree and
select Delete.

The rest of the work will be done in the clipsbpm model. There are still many
errors. These will be corrected as you specify more implementation details.

Complete the clipsbpm monitor model

Now you will complete the expressions for the six decision percentage metrics in
the monitor details model. There are three decisions in the process model, so there
is a yes metric and a no metric in the monitor model for the result of each
decision. There will be a measure in the dimensional model that averages each
metric, so the measure will show the percentage of the time that the branch was
taken.

If a decision has not been traversed, then you do not want to include it in the
averaging calculation. For example, the Approve Without Review? task in the
process model is the only decision point that is always traversed. Account in Good
Standing? and the Acceptable Credit Risk? tasks are only traversed under specific
conditions while the order is being handled.

If the value of a metric is null, then the averaging functions will not include that
metric’s value in the calculation. Therefore, you will set the default value to null
for each metric as the starting condition. Its value will only be set if the decision
point is reached. If it isn’t reached, it will remain null and therefore be excluded
from the averaging calculation.

You will also create a trigger for each decision that determines when the yes
branch is taken, sets the value of the yes metric to 100, and also sets the value of
the no metric to 0. Then you will create a trigger for each decision that determines
when the no branch is taken, sets the value of the no metric to 100, and also sets
the value of the yes metric to 0. Therefore, when the measure averages each metric
for the instances, the values will be null, 0 or 100, and the average will represent
the percentage of the time that the branch was taken.

From the process model, only the Approve Without Review? task is guaranteed to
always be set to a non-null value at the completion of the process. Of the other
two, at least one task will be set to non-null and possibly both, depending on the
path the customer order takes through the process.

In the following expressions, the WebSphere Integration Developer BPEL editor
contains the names of the links (for example,
“AcceptableCreditRiskOutput_to_Merge2Input2”) for the process.

1. Create triggers to indicate flow on each of the decision links:

a. In the Monitor Details Model tab, expand clipsbpm and select
OrderHandling (Futurel). Right-click in the Monitor Details Model
navigator, and select New » Trigger. (You can right-click OrderHandling
(Futurel) or anywhere in the Monitor Details Model as long as
OrderHandling (Futurel) or one of its components is selected.)

b. For the name, enter Acceptable Credit Risk Yes Trigger. Click OK. The
Monitor Details Model tab view now displays the details for this trigger.
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Note that selecting an element in the Monitor Details Model navigator
updates the view with the details for the selected element.

. In Trigger Sources, click Add (or double-click in the first row). From the
Select Trigger Source menu, select Other source type and navigate to
Order Handling (Future 1) » OrderHandlingFuturel FlowCONDTRUE.
Click OK. OrderHandlingFuturel _FlowCONDTRUE is an event that is sent
when a branch from the flow is taken in the process.

. To fire this trigger when the link from Acceptable Credit Risk to the Merge
is traversed, in the Trigger Condition field, enter the following text:

OrderHandlingFuturel F1owCONDTRUE/BPELData/bpc:elementName eq
"AcceptableCreditRiskOutput_to_MergeZInput2'’

Note: Pay close attention to the text in the trigger condition. It must match
exactly. To ensure that the text matches exactly, copy it from this
document.

Save your work.

= Trigger Sources
Specify the source of this trigger.

Source Type | Source
Ewvent &' CZrderHandlingFuture _FlovZORGTRUE

+ Trigger Condition
Specify the condition that determines whether the trigaer will Fire.

OrderHandlingFuturel _FlowCONDTRUESEPELD ata/bpe:elementame eq
‘ArcceptableCreditRiskoutput_to_Merge2Inpukz’

. Repeat the previous steps for the following triggers, adding the
corresponding trigger conditions. The Trigger Source is Order Handling
(Future 1) » OrderHandlingFuturel FlowCONDTRUE for all the triggers.

Acceptable Credit Risk No Trigger
Condition: OrderHandlingFuturel F1owCONDTRUE/BPELData/
bpc:elementName eq
"AcceptableCreditRiskOutput2_to_CancelOrderandSendNotificationInput'

Account in Good Standing Yes Trigger
Condition: OrderHandlingFuturel F1owCONDTRUE/BPELData/
bpc:elementName eq
"AccountinGoodStandingOutput to Merge2Input'

Account in Good Standing No Trigger
Condition: OrderHandlingFuturel F1owCONDTRUE/BPELData/
bpc:elementName eq
"AccountinGoodStandingOutput2_to_MergelInput'

Approve Without Review Yes Trigger
Condition: OrderHandlingFuturel F1owCONDTRUE/BPELData/
bpc:elementName eq
"ApprovelithoutReviewOutput to CheckCustomerAccountStatusInput'
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f.

Approve Without Review No Trigger
Condition: OrderHandlingFuturel F1owCONDTRUE/BPELData/
bpc:elementName eq
"ApprovelithoutReviewOutput2_to Mergelnput2'

Save your work.

2. Set flow metric values to denote that the decision was skipped (value of null)
or that the flow path was taken (value of 100) or not taken (value of 0).

a.

In the Monitor Details Model tab, select the Acceptable Credit Risk? No
Percentage metric.

Remove the default value of 0 by backspacing over it. Deleting this value
will give the default a value of null.

In the Metric Value Expressions table click Add.

In the Trigger column, select the first row, click ... in the field, and select
Acceptable Credit Risk Yes Trigger from the dialog box. Click OK.

In the Expression column, select the first row and click ... in the field, and

enter 0.

f. In the Metric Value Expressions table click Add. For the trigger, select
Acceptable Credit Risk No Trigger. For the expression, specify 100.

Trigger | Expression
:':P Acceptable Credit Risk Yes Trigger =$Y i}
:':P Acceptable Credit Risk Mo Trigger ng 100

g. Repeat the previous steps for the following metrics. Remember to remove
the default value for each metric so it is treated as null.

Monitor Details Metric Value
Model Metric Default Value Trigger Expression
Acceptable Credit <empty> Acceptable Credit 100
Risk? Yes Percentage Risk Yes Trigger
Acceptable Credit 0
Risk No Trigger
Account in Good <empty> Account in Good 0
Standing? No Standing Yes Trigger
Percentage Account in Good 100
Standing No Trigger
Account in Good <empty> Account in Good 100
Standing? Yes Standing Yes Trigger
Percentage Account in Good 0
Standing No Trigger
Approve Without <empty> Approve Without 0
Review? No Review Yes Trigger
Percentage Approve Without 100
Review No Trigger
Approve Without <empty> Approve Without 100
Review? Yes Review Yes Trigger
Percentage Approve Without 0
Review No Trigger

h. Save your work.
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3. Alerts are initiated by situation events. Specify the trigger conditions that will
generate situation events for the Alerts.

a.

Select the KPI Model tab and expand clipsbpm » Template KPI Context.
Select Average Process Duration Trigger 1 so that you can update it. The
Average Process Duration Trigger 1 trigger will be used to emit the
situation event indicating that the process duration is too long. A situation
event is used to initiate an alert.

In the Trigger Source table, click Add and select Recurring wait time.
Click OK. The recurring wait time default is 1 minute. Adding the
recurring wait time sets a timer that will check the trigger condition every
minute.

For Trigger condition, enter the following expression:

Average_Process_Duration ge dayTimeDuration('P3DT1H')

* Trigger Sources
Specify the source of this trigger,

Source Type | Source
.
Recurring wait time b 0 davs 0 hours 1 minukes

+ Trigger Condition
Specify the condition that determines whether the trigaer will Fire.

Average_Process_Duration ge davTimeDuration] PSOT1HY

The trigger condition checks whether the Average Process Duration is
greater than 3 days and 1 hour.

Repeat the previous steps to update Percentage of Orders Shipped
Trigger 1. The Percentage of Orders Shipped Trigger 1 trigger will be used
to emit the situation event indicating that the percentage of shipped orders
is too low. For the trigger condition, enter the following expression:

Percentage_of_Orders_Shipped < 85

+ Trigger Sources
Specify the source of this trigger,

Source Type | Source
.
Recurring wait time b 0 davs 0 hours 1 minukes

+ Trigger Condition
Specify the condition that determines whether the trigaer will Fire.

Percentage_of _Orders_Shipped = 89
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4. The Average Process Duration KPI will now be implemented.
a. From the KPI Model tab, select Average Process Duration.

b. Because this was copied from another model, you need to update the
Monitoring context. Scroll down to the KPI Details section. Click Browse
for Monitoring context, and navigate to clipsbpm » Order Handling
(Future 1). Then click OK. The metric value is blank.

Note: There is another KPI, Order Handling (Future 1) Average Elapsed
Duration, which has the same function as Average Process Duration. Order
Handling (Future 1) Average Elapsed Duration was auto-generated. You
can review it to see which metric should be used. It will be filled in during
the next step.

c. While you are still in the KPI Details section, click Browse for Metric and
then navigate to Order Handling (Future 1) > Order Handling (Future 1)
Elapsed Duration for KPI. Click OK.

d. Set the Aggregation function to Average from the drop-down list.

KPI Details
Monitoring context: | OrderHanding (Future1)
Metric: " OrderHandiing (Future 1) Elapsed Duration for KPI
Aggregation function: N Average [v]
Use values from: (®) Al mode! versions (O Only this version of the model

e. In the KPI Model tab, select Order Handling (Future 1) Average Elapsed
Duration, right-click and select Delete. It is a duplicate of the Average
Process Duration KPI.

f. Save your work.

5. In the KPI model, implement the KPI Percentage of Orders Shipped. To
calculate the percentage of orders that are shipped, you will create a KPI for
the number of shipped orders, and you will create another KPI for the total
number of orders. Then you can determine the percentage by dividing the
shipped orders by the total orders:

a. Click the Monitor Details Model tab, right-click in the Monitor Details
Model navigator, and select New > Trigger.

b. For the name, enter Shipped Order Trigger and click OK.

c. In Trigger Sources, click Add and then select Other source type. Navigate

to Order Handling (Future 1) » Ship Order to CustomerEXIT and click
OK.

= Trigger Sources
Specify the source of this trigger,

Source Type | Source
Ewent r,';':' Ship Order ko CustomerEXIT

d. In the Monitor Details Model tab, right-click in the Monitor Details
Model navigator and select New » Trigger.

e. For the name, enter Cancelled Order Trigger, click OK.

f. In Trigger Sources, click Add and then select Other source type. Navigate
to Order Handling (Future 1) » Cancel Order and Send NotificationEXIT
and click OK.
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+ Trigger Sources
Specify the source of this trigger,

Source Type | Source
Ewent r,';':' Cancel Order and Send MatificabionEXIT

6. Create a new metric to contain the status of the Order.

a.

Right-click in the Monitor Details Model navigator and selectNew -
Metric.

For the name, enter Order Status. For the type, select String and click OK.

Because a dimension will use this metric, and dimensions require a value
for dimensional analysis, select “A value is required for this metric’.

For the Default value, enter 'New' with the quotation marks.

In Metric value expressions, click Add. In the Trigger cell, select
Cancelled Order Trigger for the trigger. In the Expression cell, enter
'Cancelled' with the quotation marks.

Note: You have to click the ... icon in the cell to enter the text.

Again, in Metric Value Expressions, click Add. In the Trigger cell, select
Shipped Order Trigger for the trigger. In the Expression cell, enter
'Shipped' with the quotation marks.

w Metric Yalue Expressions

Specify the expressions that sek the value of the metric,
trigger Fires,

Trigger | Expression
55':9Cancelled Order Trigger =+-3Y ‘Cancelled'
EE':PShi|:||:n3|:| Cirder Trigger ﬁv ‘Shipped'

7. Create a new KPI to count the number of shipped orders. You will use the
Instance ID metric to count all incoming instances and then filtering the
incoming instances by order status so only shipped orders are counted. You
will also filter the instances by the process state so that only completed
process instances are counted. In the KPI model, create a new KPI called
Shipped Orders:

a.
b.

e o

Se = o

Select the KPI Model tab.

In the KPI model navigator, right-click and select New » KPI. For the
name, enter Shipped Orders and click OK.

Set the Type to Decimal.

Scroll down to the KPI Definition section if it is not visible. For KPI value,
select ‘Base this KPI on a metric and an aggregation function’.

For the Monitoring context, browse to Order Handling (Future 1).
For the Metric, browse to Order Handling (Future 1) Instance ID.
For the Aggregation function, select Count.

For the Data Filter, click Add and then browse to Order Handling (Future
1) » Order Status. Then click OK. In the Values cell, enter 'Shipped' with
the quotation marks.

Again in the Data Filter, click Add and then browse to Order Handling
(Future 1) » Order Handling (Future 1) State. Then click OK. In the values
cell, enter '3 - STATE_FINISHED' with the quotation marks.
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10.

Data Filter

Select the metrics that you want to use ko determine what values o use in the calculation. For example, if you have a KPI called Average Price in London,
au onlky wank to use monitaring contexts where the value of the City metric is London,

Mekric | Cperator | Yalues | Case-sensitive |
J-iorder Status equals =3 'Shipped' H
i 'order Handling (Future 1) State equals Y 3. STATE_FINISHED' O

Create a KPI to count the total number of orders. You will use the Instance ID
metric to count all incoming instances. You will also filter the instances by the
process state so that only completed process instances are counted. In the KPI
model, create a new KPI called Total Orders:

a. In the KPI model navigator, right-click and select New > KPI. For the
name, enter Total Orders click OK.

Set the Type to Decimal.

13

For the KPI value, select ‘Base this KPI on a metric and an aggregation
function’.

For the Monitoring context, browse to Order Handling (Future 1).

For the Aggregation function, select Count.
For the Data Filter, click Add and then browse to Order Handling (Future

1) » Order Handling (Future 1) State. Then click OK. In the values cell,
enter '3 - STATE_FINISHED' with the quotation marks.

d
e. For the Metric, browse to Order Handling (Future 1) Instance ID.
f
g

Data Filter
Select the metrics that vou want to use to determing what values to use in the calculation. For example, if vou have a KPI called Average Price in London,
wou only want o use monitoring contexts where the value of the City metric is Londaon,

Mekric | Operator | Yalues | Case-sensitive |

A~ ©rder Handling (Future 1) State equals =§Y '3 - STATE_FIMISHED'

Now you will complete the Percentage of Orders Shipped KPI:
a. In the KPI model navigator, select KPI Percentage of Orders Shipped.
b. Set the Type to Decimal.

c. For the KPI Value, select "Write an expression to calculate this KPI based
on existing KPIs'.

For the KPI Calculation, enter (Shipped Orders div Total Orders) * 100.
Save your work.

KPI Calculation
Faor example, vou could have a Tokal Profit KPT that subtracks the Tatal Cast KPI From the Total Revenue KPT

(shipped_COrders div Total_Crders) * 100

In the next procedure, you will create the ShippedPercentage.cbe event
definition. This event is used to initiate an alert when there is a problem with
the shipped orders percentage.

a. In the project tree, right-click Event Definitions and then select New »
Event Definition ... (cbe). For file name, enter ShippedPercentage.cbhe, and
then click Finish. The event definition editor opens.

b. Double-click the hierarchical icon next to the label Parent

On the Select Event Definition dialog box, double-click
ActionServicesEvent. ActionServicesEvent is now shown as the parent of
ShippedPercentage.
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1.

12.

Mame™® ShippedPercentage
ent* ActionServicesEvent
Property
Extended Data Type

d. Save your work.

Use this event definition to create the Shipped Percentage Event outbound
event definition in the monitor model:

a. In the clipsbpm model, click the KPI Model tab.

b. In the KPI Model navigator, right-click and select New » Outbound Event.
c. For the Name, enter Shipped Percentage Event.
d

Select the check box for “Configure this event to generate an alert in the
dashboards’.

e. For the Trigger, browse to Template KPI Context » Percentage of Orders
Shipped Trigger 1 and click OK.

Click OK.

g. In Event Type Details, for the extension name, browse to clips »
ShippedPercentage.cbe » Shipped Percentage and then click OK.

—n

h. In Event Attributes Details, navigate to BusinessSituationName. The value
of the situation name is set to "Shipped Percentage Event’.

+ Event Attributes Details

Specify the triggers that cause the event to be sent, Use the Expression column to specify the
attribuke when the event is sent,

Mame Type Expression

B 7 Percentage of Orders Shipped Trig
% Property Data
= [I% Extended Data
E BusinessSituationMame A string

bt
1

'Shipped Percentage Event'

i. Save your work.

Create the OrderFulfillmentTime.cbe outbound event for the order processing
time situation:

a. In the project tree, right-click Event Definitions and select New » Event
Definition... (cbe).

b. For the file name, enter OrderFulfilImentTime.cbe and then click Finish.
The event definition editor opens.

c. Double-click the hierarchical icon next to the label Parent. On the
Select Event Definition dialog box, double-click ActionServicesEvent.
ActionServicesEvent is now the parent of OrderFulfillmentTime.

In the Extended Data section, click the Add Extended Data icon

Change the name of the extended data element to OrderDuration and
change the type to string.
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Tame* OrderFulfilmentTime
Parent™ ActionServicesEvent
Properky
Extended Data Type
OrderDuration skring

f. Save your work.
13. Create the Order Fulfillment Event outbound event:

a. In the clipsbpm model, click the KPI Model tab.

b. Right-click in the navigator, select New » Outbound Event.
c. For the Name, enter Order Fulfillment Event.
d

Select the check box for “Configure this event to generate an alert in the
dashboards’.

e. For the Trigger, browse to Template KPI Context > Average Process
Duration Trigger 1 and click OK.

f. Click OK.

g. In Event Type Details, for the extension name, browse to clips »
OrderFulfillmentTime.cbe » OrderFulfillmentTime and then click OK.

h. Again in Event Attributes Details, navigate to BusinessSituationName.
The value of the situation name is set to 'Order Fulfillment Event'.

i. Set the expression for OrderDuration to
xs:string(Average_Process_Duration).

+ Event Attributes Details

Specify the triggers that cause the event to be sent, Use the Expression column ko specify the value for
each exvent attribute when the event is sent,

Marne | Tvpe | Expression |
= :':P Average Process Duration Tt
% Property Data
=] [Fé Extended Data
E‘% OrderDiuration A skring ﬁv xsistring(Average_Process_Duration)

= BusinessSituationMar i string >§+-3Y ‘Order Fulfillinent Event’

j. Save your work.

Note: Notice that in both of the events (CBEs) created above that the
Extended Data element BusinessSituationName was not created. This is
because it is inherited from the parent event ActionServicesEvent. Actually, the
ShippedPercentage.cbe did not even need to be created. The outbound event
Shipped Percentage Event in the monitor model could have been created
with the default Extension name of ActionServicesEvent.cbe »
ActionServicesEvent. Event definitions (CBEs) for situation events only need
to be created if Extended Data other than BusinessSituationName is needed.
This is frequently the case however as additional process or business data is
typically needed in the Alert and thus must be carried in the event.

14. There are count measures in the monitor model that will now be removed,
these counts can be derived from a provided measure named Instances
Count.

a. Click the Dimension Model tab.

b. Delete Declined Order Count, Order Count, and Shipped Order Count.
Instead, you can get this information using the provided measure
InstancesCount and then creating a dimension on Order Status which will
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15.

16.

17.

be used to aggregate order instances by the order status, e.g. new orders,
shipped orders, and cancelled orders. In effect, this counts the order
instances by their status.

Create the dimension Order Status so that orders can be aggregated by their

status.

a. In the Dimensional Model navigator, right-click Order Handling (Future 1)
Cube, then select New » Dimension.

For the Name, enter Order Status and then click OK.

In the Dimensional Model navigator, right-click Order Status and select
New > Dimension Level.

d. Name the dimensional level Order Status. Then click Browse next to
Source Metric and navigate to Order Handling (Future 1) > Order Status.
Then click OK.

Source metric: | Order Skakus

Lewvel: | 1
*!

e. To see the dimension level, click Order Status under Order Status.

Create the State dimension so that orders can be aggregated by the process
completion state.

a. In the Dimensional Model navigator, right-click Order Handling (Future 1)
Cube and then select New » Dimension.

For the Name, enter State.

In the Dimensional Model navigator, right-click State and select New -
Dimension Level.

d. Name the dimension level State. Then click Browse next to Source Metric,
and navigate to Order Handling (Future 1) > Order Handling (Future 1)
State. Then click OK.

e. Click OK. There is an error on this dimension because the Order Handling
(Future 1) State metric is not initialized when the monitoring context is
created. To solve this problem, in the Monitor Details Model tab, update
the Order Handling (Future 1) State metric by selecting A value is
required for this metric’ and changing the default value to "New’,
including the quotation marks.

There is a dimension called Location in the dimensional model, but there are
errors associated with it. This dimension came from the business measures
model, and it should contain two levels: the country and the city. Create
metrics for country and city and then update the Location dimension to refer
to the metrics.

a. Right-click in the Monitor Details Model navigator and select New »
Metric.
For the name, enter Country. For the type, select String. Then click OK.
Because a dimension will use this metric and the metric requires a value
for dimensional analysis, select “A value is required for this metric’.

d. For the default value, enter an empty string, which is two single quotation
marks.

e. In Metric value expressions, click Add. In the Expression cell, use content
assist (Ctrl + Space bar) to navigate to the following inbound event field
for country:

Check_Order_Handling_Policy for_Automatic_ApprovalENTRY/Input/Customer/Country
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+ Metric ¥alue Expressions

Specify the expressions that set the value of the metric. If a btrigger is specified, the map is evaluated when the trigger fires.
Trigger I Expression I
:':9‘ =?\, Check_Crder_Handling_Policy_For _Automatic_approvalEMTR Y Inpuk fiCustomer iCountry

f. Create a City metric, following the previous steps but selecting the
following inbound event field for city:

Check_Order_Handling_Policy_for_Automatic_ApprovalENTRY/Input/Customer/City

+ Metric ¥alue Expressions
Specify the expressions that set the walue of the metric. IF a trigger is specified, the map is evaluated when the trigger fires.

THi | Exeression |

-2 Check_Order_Handling_Policy_for_Automatic_approvalENTRY [ InputfCustomer [ City

18. In the Dimensional model, update the Location dimension with the two
metrics:

a. In the Dimensional model, delete the Location level under the Location
dimension.

b. In the Dimensional Model navigator, right-click Location and select New -
Dimension Level.

c. Name it Country and then click Browse next to Source Metric and navigate
to Order Handling (Future 1) » Country. Then click OK.

Click OK.

In the Dimensional Model navigator, right-click Location and select New -
Dimension Level.

—h

Name it City and then click Browse next to Source Metric and navigate to
Order Handling (Future 1) » City. Then click OK.

g. Click OK. In the Dimensional Model navigator, Location is listed with two
sublevels:

ocation

=84

19. In the Dimensional model, update the Order Price Average measure. You will
create a price metric to use as a source for this measure.

a. Right-click in the Monitor Details Model navigator and select New -
Metric.

b. For the name, enter Total Price. For the type, select Decimal. Click OK.

c. In Metric value expressions, click Add. In the Expression cell, navigate to
the following inbound event field for total price:

Check_Order_Handling_Policy_for_Automatic_ApprovalENTRY/Input/TotalPrice

+ Metric ¥alue Expressions
Specify the exprassions that set the value of the metric, IF a trigger is specified, the map is evaluated when the trigaer fires.

If = | Expression I

- =§ Check_Order_Handling_Policy_For_fuktomatic_ApprovalENTRY /Input) TakalPrice

20. In the dimensional model, update the Order Price Average measure with the
new metric:

a. Select the Dimensional Model tab and then select the Order Price
Average measure.
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b. For the source metric, browse toOrder Handling (Future 1) » Total Price
and click OK.

Source mekric: 4 Total Price

21. In the dimensional model, update the Order Price Total measure with the new

metric:
a. Select the Dimensional Model tab and then select the Order Price Total
measure.
b. For source metric, browse to Order Handling (Future 1) » Total Price and
click OK.
Source mekric: 4 Total Price

c. Save your work.
d. Select Project » Clean, and then select “Clean all projects’. Click OK.

e. Check for errors in the Problems view and resolve the errors before
continuing. Warnings and informational messages might be present, but
they will not be a problem. If the errors do not disappear, close WebSphere
Integration Developer, reopen WebSphere Integration Developer, and then
rebuild all the projects by clicking Project > Clean.

Generate executable artifacts for the monitor model and deploy to the
server

Now you will use WebSphere Integration Developer to deploy the monitor model
to the WebSphere Business Monitor server.

1. Generate the model.

a. In the project tree, expand clips > Monitor models ~ clipsbpm.mm.
Right-click clipsbpm.mm and select Generate Monitor J2EE Projects. When
generation is complete, select Finish. A progress dialog box shows the
status of the operation and it closes when the operation is complete. This
will take a few minutes.

b. Check for errors in the Problems view. There might be warnings, but there
should not be any errors. If you see errors, rebuild by selecting Project
Clean. Select Clean all projects, and then click OK.

2. Next regenerate the forms user interface for the Order Handling process.
a. Click the Business Integration tab in the left pane.

b. Right click on ClipsAndTacksF1 from the left pane and select Generate User
Interfaces.

c. Select IBM Lotus Forms client as the Generator type, and click Next.
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r Interface r Human

Client Generator Selection
Select 5 generator type and human tasks to generate a user interface. _—

Generator type |BMlotsFomsdient ]
Human Task(s) | = [#] ClipsAndTacksF1 Select Al

|| Processes
=[] OrderHandlingFuture 1

Invocation

CrderHandlingFuture 1_InputCriterion

To-do

ShipOrdertoCustomer _InputCriterion

ReviewOrder_InputCriterion

d. Name the dynamic Web project C1ipsAndTacksUI. For the style, select IBM
Style and click Finish.

r Interface r Human

IBM Lotus Forms client configuration
Spedify destination project, company logo, dient location and style for your dient. i

MName of dynamic web project: | ClipsandTacksUI |

Company logo: | |

Client location

(*) Generated dient and related processes [ tasks reside on the same server. {Local dient view)
(") Generated dient and related processes [ tasks reside on different servers, (Remote dient view)
Frovider URL: iop:f/REMOTE_SERVER_IP:BOOTSTRAF_PORT |

Style selection
Style:  |IBMStyle
icy: EE——
RS i Edit... | | Remove
@ [ <Back || mext> || Ensh |[ cancel

e. When you see the Client generation completed message, click OK.
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& Client generation completed.

The Lotus Form dient has been generated to a Web Project called
"ClipsAndTacksLI",

‘(C'ﬂ

How to deploy and launch the dient, select help icon below.

3. Deploy the generated projects.

a.

—h

@

Click the Servers tab and then right-click WebSphere Business Monitor
v6.1 on WebSphere Process Server and select the Start option to start the
server. Starting the server might take a few minutes.

|M0nit0ring Flow | Properties | Problems m\ngress |

Status State

vebSphere Business Monitor vé. 1 i Started Republish

Ei_.‘} webSphere Process Server v, 1 = Stopped Republish

After the server has started, right-click WebSphere Business Monitor v6.1
on WebSphere Process Server again and select Add and Remove Projects.

Move ClipsAndTacksF1App, ClipsAndTacksUIEAR, and
clipsbpmApplication from the list of available projects to the list of
configured projects (you can use Add All if there are no other projects in
your workspace) and then click Finish. A progress message displays in the
lower right-hand corner of the window. Deploying and starting the
applications might take a few minutes.

Check the messages in the Console view for errors. Note that because the
application was just installed, there are no values for the KPIs and other
metrics yet. The Console view will show warning and error messages to
this effect. The messages will be from the kpi package and indicate a divide
by zero exception. This is expected until Orders are processed. The
messages will repeat every minute until an Order is processed. This is
because earlier in the model it was specified to check the KPI based on a
“recurring wait timer” set at 1 minute.

In the Servers view, right-click and select Run administrative console. The
administrative console will open in a new tab.

The administrative console will prompt you for a user ID and password. For
the user ID, enter admin. For the password, enter admin Click Log in.

Select Applications » Monitor Models.
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1 200,
Integrated Solutions Console Welcome admin Help | Legout | :::ﬁ
‘

Manitor Models

¥iew: | All tasks ~|

Manitar Madels
Wakame

Guigea Activitie Monitor Models
oo Use this page to manage all versions of monitor models and their associsted applications. To start or stop a version of 3
maonitor model, you must start or stop the associated application, All models are initially added to the raot rezaurce grouy
O applcatians and may not be visible by its intended dashboard users, Use the Monitor data security panel to assign permission to the
i . models,
Enleipiise tpplcalans
[rztall Hewr Apphzatian Preferences
S Start| Siap| [ tnstan | [ upgate
Hanila Hadels
k]| i
Dala Mavemenl Sevioe B ?
Manilar Action Ganwices
Select| Made| £ Warsiem Deployment & Application 2 Status ¢
Rezauices
[] |@lebaluTea  zo07-06- ok IBM WBM HUMAN TASK MONITOR MODEL | &
Secutily 18T09:54:38
e e — [ | dlieskem 2008-01- oK clipsbpmapplication P

30T1d4:32:48

Inlegratian Applcalans
Total 2
Syslem adminizlialian

Uszis and Giaups

Service inlagratian

upet

If the application starts, it will show a green status. If the status of clipsbpm
is red, then it is stopped. Wait a moment and then refresh the process by
clicking the icon to the right of Status in the last column of the table. You
should see green to indicate that the model has started. If the model does
not reflect green, wait a few more minutes and refresh the display again.

h. In the Console view, check the server log to ensure that there are no
problems other than the KPI divide by zero exception mentioned earlier
that is due to no orders having been processed yet.

i. By using the integrated WebSphere Business Monitor server in WebSphere
Integration Developer, you do not need to set up WebSphere Business
Monitor data security because the administrator is automatically authorized
to access all models. When using an external server in future projects, open
the administrative console, navigate to Security > Monitor Data Security,
and then add the model, role, and user information to a resource group.

Configure Action Services for business situation events

Next configure WebSphere Business Monitor’s Action Services to create alerts
when business situation events are received. The situation events are sent from the
monitor model as outbound events. The alerts will be visible in the Alert view on
your dashboard. You do not need an LDAP server to test the situation events as
was necessary in previous releases.
1. Add an alert template for when the percentage of shipped orders needs
attention.
a. In the administrative console, select Applications » Monitor Action
Services » Template Definitions » Notifications and click New.

For the template name, enter AlertShip, and then enter any description.

Select Dashboard Alert. This indicates that the an alert (defined below) will
be sent to the business dashboard’s alert view.

Select User id.

For the To field, enter admin. This user ID is the user logged into the
business dashboard that will receive the alert. You must log into the
business dashboard with this user ID.
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f.

For Subject, enter Percentage of shipped orders. This will be the title of
the alert in the dashboard. Enter the Body as Percentage of shipped orders is
less than 85. Click OK.

To
|admin

Query base

Subject
Percentage of shipped orders

Body

Percentage of shipped orders is l:‘
less than 85

=

2. Add an alert template for when order processing time needs attention.

a.

h.

In the administrative console, select Applications » Monitor Action
Services » Template Definitions » Notifications and click New.

For the template name, enter AlertTime, and then enter any description.
Select Dashboard Alert. This indicates that the an alert (defined below) will
be sent to the business dashboard’s alert view.

Select User id.

For the To field, enter admin. This user ID is the user logged into the
business dashboard that will receive the alert. You must log into the
business dashboard with this user ID.

For Subject, enter Order processing time.

For the Body enter The average order processing time is
%0rderDuration% days.

%QOrderDuration% is a substitution variable in the alert. In the alert that
will be sent, the situation event’s Extended Data Element, OrderDuration,
will be substituted for %OrderDuration% in the body of the alert.

Click OK.

3. Now add the binding from the situation event to the action type of the alert
template for shipped percentage situations.

a.

C.

In the administrative console, select Applications » Monitor Action
Services » Installed Situation Event Bindings and click New.

Enter the situation event name that you defined in the model. You named
the business situation event Shipped Percentage Event. The name must
match the value in the BusinessSituationName field in the outbound event.
You might want to copy the name from the monitor model to ensure an
exact match (do not include the quotation marks). The following screen
capture from the monitor model shows the Shipped Percentage Event
attributes:

~ Event Attributes Details

Specify the triggers that cause the event to be sent, Use the Expression column ko specify the value for each event attribute
when the event is sent.

[Name Type Expression

B =7 Percentage of Crders Shipped Trigr
% Property Data
= % Extended Data
= BusinessSituationMame A string

xp
w

'Shipped Percentage Event'

Enter any description and then click Apply.
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d. In the table under Preferences, click Add.

e. Enter a binding name, for example Shipped Percentage Event, and then
select the template AlertShip.

f. Click OK. Notice that you now have one action defined for this situation
event. If you had other action templates defined, then you could add more
actions to this event and you could send a notification for this situation
event to multiple destinations using e-mail, alerts, and Web services.

Mew Situation Event Binding

General Properties

# Situation event name

|Shipped Percentage Event

De=cription
Shipped percentage event D

=

Apply | ﬂ Reset Cancel |

Preferences

Add Remove
B0 ==
~

Select| Binding Mame 3 o

Category Mame [: o

Template Hame : o

Action Service Type

r Shipped Percentage AlertShip AlertHandler
Event

Total 1

g. Click OK.
4. Add the binding from the situation event to the alert template for the action
type for order processing time situations:
a. In the administrative console, select Applications »+ Monitor Action
Services » Installed Situation Event Bindings and click New.

b. Enter the situation event name that you defined in the model. You named
the business situation Order Fulfillment Event. The name must match the
value in the BusinessSituationName field in the outbound event. You might
want to copy the name from the monitor model (without the quotation
marks).

c. Enter any description and then click Apply.

d. In the table under Preferences, click Add.

Enter a binding name such as Order Fulfilment Event, select the template
AlertTime, and then click OK.
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Mew Situation Event Binding

General Properties

# Situation event name
|Order Fulfillrnent Event

Drescription
Order fulfillment event |:|

=

Apply | ﬂ Reset Cance||

Preferences
Add Remouve
G

Select| Binding Marmme Category Marme I: Terplate Marme

- Crder Fulfillment Event AlertTime

Total 1

f. Click OK again.

Action Service Type O

AlertHandler

g. In the administrative console, select Applications » Monitor Action
Services » Installed Situation Event Bindings. You will see the two

bindings that you created.

Installed Situation Event Bindings

Installed Situation Event Bindings
Use this page to manage situation event bindings.

Preferences

Meaw Delate

Select| Situation Event Marme Situation Event Description

r Srder Fulfillrnent Event Order fulfillrent event
r Shipped Percentage Event Shipped percentage svent
Taotal 2

e

Exercise the model by running events

Now you will use the Lotus Forms client to run process instances. You access it by
entering the URL http://localhost:9080/ClipsAndTacksUI in an internet browser.

For more information, refer to the Running and testing the application section.

There are five paths through the process model. The following form data invokes

each path. The form values not specified can be any value:

* Path taken: Approve without review, Account in good standing, Ship

1. Form data to start an instance of the process.
a. Rating: 800
b. Available Credit: 800

c. Total Price: 20
2. Ship task
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a. Packing Slip Number: Any value
* Path taken: Approve without review, Account not in good standing, Approve the
order, Ship
1. Form data to start an instance of the process.
a. Rating: 800
b. Available Credit: 100
c. Total Price: 200
2. Review task:
a. Order Status: APPROVED
3. Ship task:
a. Packing Slip Number: Any value
 Path taken: Approve without review, Account not in good standing, Decline the
order
1. Form data to start an instance of the process.
a. Rating: 800
b. Available Credit: 100
c. Total Price: 200
2. Review task:
a. Order Status: REJECTED
 Path taken: Do not approve without review, Approve the order, Ship
1. Form data to start an instance of the process.
a. Rating: 10
b. Available Credit: 10
c. Total Price: 900
2. Review task:
a. Order Status: APPROVED
3. Ship task:
a. Packing Slip Number: Any value
 Path taken: Do not approve without review, Decline the order
1. Form data to start an instance of the process.
a. Rating: 10
b. Available Credit: 10
c. Total Price: 900
2. Review task:
a. Order Status: REJECTED

One way to see an alert in the Alerts view of the business dashboard is to have the
number of shipped orders less than 85 percent of the total number of orders. To
achieve this, process one rejected order before you add another process instance.
Then go to the Create a dashboard section of this tutorial and create a dashboard
to view the alerts.

Create the business dashboard

Now you will create a business dashboard. You will add views to the dashboard
and configure them.

1. Open the WebSphere Integration Developer dashboard manager.

a. In WebSphere Integration Developer, select Window » Web Browser. Select
Default system Web browser or another listed browser other than the
internal browser.

b. In the Servers view, right-click WebSphere Business Monitor Server v6.1
on WebSphere Process Server and select WebSphere Business Monitor
Dashboard.

c. When prompted, enter admin for the user ID and admin for the password.
You must log in with admin so that you can view the alerts that were set
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up in Action Services to be viewed by this particular user ID. Also, in the
WebSphere Business Monitor toolkit, this is the user that is automatically
defined on the secured server.

d. Select the Dashboards tab and then the Manage tab.

WebSphere "BUSINESS Monitor

welcome wid

Getting Started | Dashboards | Utilities |
Manage

NewI Copl,ll Renarmes I Share I Delste I Impart I Exportl

Select Dashboard -

E E‘ Page 1 of 0 |E| E‘ Go to page: I Results 1 ta 0 of 0

e. Click New and then enter a name for the new dashboard, for example
MyDashboard. Click OK.

Note: The contents in the views in the dashboards will depend on the
actual data that was entered into the forms for the orders.

WebSphere " BUSINESs Monftor

Welcome wid

Getting Started | Dashboards | Utilities |
Manage MyDashboard # |

Add to Dashboard

2. Add the instances view to the business dashboard so that you can view the
process instances:

a. Click Add to Dashboard, select Instances, and then click OK. You can also
add a view by dragging the view from the palette onto the dashboard.

In the Instances view, click Personalize.
Click the Advanced tab and select model clipsbpm (All Versions).

Instances
Show /Hide Filter Sort Formatting Advanced Cooperative

To change out the table's data set (and table setting) select 2 new Model and Monitoring context

Madel: Monitaring Context

| clipsbpm (&l Yersians) j | Order Handling (Future 1) j

d. Click the Show/Hide tab and then click >> to copy all of the metrics from
the available list to the selected list.
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3-90

Instances
Show /Hide

Set the columins to show and optionally arrange the colurnn order

Available:

e. Click OK. You will see a list of monitoring context instances for the orders
entered.

Instances
Model: dipsbpm  Version: All Versions Monitoring Context: Order Handling (Future 1)

% Search for:

Check
cancel Check  Order ord Order
Acceptable Acceptable Approve PP send Account  Policy for Handling 9 (Future
Good d 4 wiithout d d (Future Handi
Credit Risk? Credit Risk? . . Wiithout h Notification Status  Autematic .. (Future 1
Standing?  Standing? h Review? Gity COMPLETED Country (Futur
No Ye: ot Star Review? No He¥ Elapsed  Elapsed  Approval 1 psed Elapsed b
Percentage Percentage Percentage Duration  Duration Elapsed Elapsed P o Duration o
for for " Daration e Bl =
Measure  Measure for Measure
Measure
Decen
o 100 o 100 15145 1858 2875 G K j 25,2975 25.2975 25,2875 520"

PM

[4] [4] Page1of2 [»] (] Gotopage [#] Resuts1to1of1

3. Add the Human Tasks view so that you can monitor human activity in the
process instances.

a. Click Add to Dashboard and then select Human Tasks. Click OK. Note
that you can also add a view by dragging the view from the palette onto
the dashboard.

b. In the newly added Human Tasks view, click Personalize.

Select the Show/Hide tab and then click >> to copy all of the metrics from
the available list to the selected list.

Human Tasks
Show /Hide

Setthe columns to display.

Available: * Selected:

=

d. Click OK. The Human Tasks view is shown in the following figure.
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Human Tasks -

Actions_x

[~ Ctompleted Completion Time Creation Time Description Lifetime B Follow-on

= e Human Task Instance ID

r * December &, 2007 2:27:27 PM December 6, 2007 2:27:14 PM 13.515 = falze o false _AL90040116, b123d4fd, 702

* December &, 2007 4:09:22 PM Dacember 6, 2007 4:07:22 PM 1m, 59.734 5 false

false _AL:90040116,b17F97 e, 7FO2E

December 6, 2007 4:12:25 BM 12m, 565 false false _ALI0040116,b1843272. 702

aooanon

0
0

Decernber 6, 2007 4:18:18 PM Fm,3s false 0 false _ALI900401186.b1899f6d. 702t
[

* December §, 2007 4:21:14 PM December 6, 2007 4:18:53 PM 2m, 20815 false

[4] [4] Pagetof1 [M] o to page: Results 10 5 of

false _ALiS0040116,bigazdcd, 7702

4. Add the dimensions view and configure it to show human task information in
aggregate form:

a.
b.
c.

f.

Click Add to Dashboard, select Dimensions, and then click OK.
Click Personalize.

In the personalization screen, select the following values:

* Monitoring Model: Global HT MM (All Versions) .

Note: This is the global human task monitor model that is automatically
installed when you install the toolkit.

* Monitoring Context: Global Human Task.

From the Available Dimensions list, select Task Name Dimension and

click the right direction arrow () next to the Row Dimensions
selected list.

Select Task Owner Dimension and click the right directional arrow (
) next to the Column Dimensions selected list.

Select Measures and click the right direction arrow () next to the
Page Dimensions text box.

Dimensions
*Manitaring Madel: *Monitaring context:
Global HT kb (&1l Yersions) ~| | Global HumanTask =]
Available dimensions Row dimensions

Task Status Dimensit;l
Task Kind Dimension
Task Expiry Dimensic
Task Suspended Dirr -
Task Escalated Dime

Task Parent ID Dimeat
Task Waiting For Suk
CreationTime
TerminationTime

*Column dimensions

Page dimensions

[~ Hide rmenu bar
[~ Hide toolbar
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g. Click OK. The Dimensions view
and task owner.

displays the instances count by task name

Measures [ InstancesCount =1

All Task Owner

Dimension N

5 — Task Marne Dimension 1L

All Task Name Dimension T

InstancesCount
w
|

All Task Owener Dimension
Task Owner Dimension

/ All Task Hame Dimension

5 k3

h. Optional. You can double-click All Task Name Dimension and All Task
Owner Dimension and drill down to more detailed data. This is
performed in the vast majority of cases.

Measures [ InstancesCoun

t

=

25—

Task Hame Dirmenzion

All Task

L owner Tl Unassignedtl  admint)
Dimension

24

All Task Name Dimension 1} 3 3

n
I

ReviswOrder_InputCriterion TL 1 1

shipordertaCustorner_InputCriterion T 2 2

InstancesCount
I

=
o
|

=

admin
Task Owner Dimension

# Revieworder_InputCriterion @ ShipOrdertoCustomer_InputCriterion

CIEIRD| |

1wl

5. Add the Alerts view. There are two situation events (outbound events) defined
in the model that will generate alerts based on the configuration set in Action
Services: one situation event for shipped percentage and one for order
processing time. The latter is based on a processing time being greater than 3
days, so it will be difficult to test now. However, you can test the former alert
by ensuring that the percentage of shipped orders is less than 85 percent of
the total orders. To test the Shipped Orders < 85% alert, click Add to
Dashboard, select Alerts, and then click OK.

6. Add the KPI view to the business dashboard to monitor the KPIs defined in
the monitor model.
a. Click Add to Dashboard, select KPIs, and then click OK. You can also add
a view by dragging the view from the palette to the dashboard.
b. Click Personalize.
c. Expand clipsbpm, and select the KPIs you want to view. You can select all
of them if you wish. Click OK.

7. Next you will export the monitored values to WebSphere Business Modeler to
improve simulation results and assumptions made in the process model such
as path percentages. Only completed process instances are exported, therefore,
ensure that you have completed some process instances before you export the
values.

a. Select the Utilities tab.
b. Select the Export Values tab.

c. Select the clipsbpm model and then click Export.
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Utilities
KPI Manager | Export Walues | Alert Subscription

Select a radel:

clipsbpm 2007-11-1211:17:05 j

Expaort data fram:
0 &ll verzions of the zelected model

o Only the salacted model

Time range (filters the data to export by the time range you speciful:

0 Mone

o Specify time range

Preview Data |

The data exported as XML opens in a browser window.

d. Click File » Save page as or File » Save as (depending on your browser)
and then select your destination folder and click Save. By default, the file
is stored as exportvalues.xml. If your browser window does not have a
File menu, then copy and paste the content into a file.

e. Open WebSphere Business Modeler with the workspace that contains
your process model.

f. In the project tree, navigate to ClipsAndTacksF1 » Processes » Order
Handling (Future 1).

g. Right-click Order Handling (Future 1) and select Import.
h. Select Monitoring result (.xml) and then click Next.

i. Browse to the folder that contains the exportvalues.xml file and select the
file. Click Next and then click Finish.

In the project tree, double-click the process to open the process diagram.
Examine the process diagram to see the updated decision percentages for the
six simple decisions.

80.0% Yes

Acceptable Credit
Risk?

20.0% Mo

Examine the updated process duration time by clicking the background of the
process diagram. Click the Attributes tab and then the Duration tab.
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10.

1.

e 1) Business Measures | Errors (Filker matched 2 of 2 items) | Technical Attributes View
(General Cost and Revenus _ Inputs Qutputs Input Logic Qutput Logic Organizations Classifiers

Processing kime

The length of time required to finish this process,

Days Hours Minutes Seconds Milliseconds

o B [ == B [= = ] =

Examine the updated task duration times by clicking one of the tasks in the
process diagram. Click the Attributes tab and then the Duration tab. Next
click the icon for "Processing time’.

Business Measures | Errors (Filker matched 2 of 2 items) | Technical Attributes View |

(General Cost and Revenue n Inputs Qutputs Input Logic 2utput Logic Resources Organizations
W Processing time

The length of time required to finish this task,

Days Hours Minutes Seconds Milliseconds

E =HC =0 =NE .

Add a dynamic KPI to the dashboard.
a. In the business dashboard, click Utilities and then KPI Manager tab.
b. In the Model field, select clipsbpm. In the Version field, select Latest.

WebSphere "Business Monitor

Welcome admin

Getting Started Dashboards | Utilities

KPI Manager = Export Valuss | Alert Subscription

Model: | clipsbem (%]  version: | Latest v
S e

(O Aversge Process Durstion Modeled - Aggregate Shared

(O orderHandling (Futurel] Average Working Duration Meodeled - Aggregate Shared

() Percentage of Crders Shipped Modeled - Expression Shared

() shipped Orders Modaled - Aggragate Sharad

() Total Orders Medeled - Aggregate Shared

c. Click Actions and select New Expression KPI.

d. For the name of the KPI, enter Declined Orders.

e. For the model associated with the KPI, select clipsbpm.

f. For Access, select Shared so that other users can see the new KPL
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New Expression KPI Properties

Hame Definition Range Other Preview

* KPI name:

Declined Orders

Description:

Model associated with KPI:

| clipsbpm [1]

Access!

O Parsonal

@ Shared

12. Create the expression for the new Declined Orders KPI.

a.
b.
c.

Select the Definition tab.
Use the KPI drop down list to select Total Orders and click Insert.

Use the Operator drop down list to select — (minus) and click Insert.

Use the KPI drop down list again to select Shipped Orders and click
Insert.

New Expression KPI Properties
Name Definition Range Other Preview
Specify the expression that will define the KPI value:

KPI:
Shipped Orders [1] [ Insert]

User-defined functions:

) =)

Operator:
- [il [ Insert]

Specify the expression that will define your KPI:

Total_Crders - Shipped_Orders

e. Click Apply.

f.

Select the Range tab.

g. For Range definition, select Numerical.

h. Add two rows as shown below by clicking Add row and entering the

following values and selecting the following colors. Click OK.

Build it yourself 3-95



Range Name Start Value End Valua Color Icon Delete

low declined orders =0 =2 .
high declined orders =z =3 . o
i. Select the Dashboards tab.

j. On the KPI View, click Personalize, expand clipsbpm and select Declined
Orders (the newly created KPI). Click OK. The new KPI view includes the
dynamic KPI that just built.

KPIs
Select KPIs Layout

Maodel version:

{:}AII “Yersions '@} Latest Wersions

El ] clipsbpm 2007-12-18 20:36:14
Average Process Duratiopn
Declined Orders
|:| OrderHandling [Futurel) Average Working Duration
Percentage of Orders Shipped
I:l Shipped Orders

D Total Orders

The new KPI view includes the dynamic KPI that just built.

KPIs

KPI Name Status Value Target Value in Range

Average Process Duratiopn 3d,0h,0m.0s __
Percentage of Orders Shipped S0 _=

Debug information

This section contains the debug information you can use for this sample.

Symptom:
ExceptionUtil E CNTRO0020E: EClassifier "http://ClipsAndTacksF1/
Businessitems#Notification” not found in ClassLoaderScope:
com.ibm.ws.classloader.CompoundClassLoader@20b220b2

Explanation:
This runtime error might occur after you set the status as REJECTED. If so,
it is likely that the project name you created in WebSphere Business
Modeler is not ClipsAndTacksF1, causing a namespace mismatch in
CancelOrderandSendNotificationImpl java.
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User response:

Change the namespace definition in
CancelOrderandSendNotificationImpl.java to ClipsAndTacksF1.

Symptom:

ExceptionUtil E CNTRO0020E: EJB threw an unexpected (non-declared)
exception during invocation of method

"transactionNotSupported ActivitySessionSupports” on bean
"Beanld(ClipsAndTracksF1App#ClipsAndTracksF1E]B jar#Module, null)".
Exception data: java.lang.NullPointerException at
com.clipstacks.credit.CreditRating.calculateCreditRating(CreditRating java:47)
at sca.component.java.impl.CheckCustomerAccountStatusImpl.
InputCriterion(CheckCustomerAccountStatusImpl.java:38)

Explanation:

This runtime error might occur after you add input data into
OrderHandlingFuturel.

User response:

Regenerate the user interfaces for the forms, ensuring that the building
workspace is completed and the server is starting before you regenerate
the user interfaces.

To import the completed projects, complete the following steps:

1.
2.
3.

Start WebSphere Integration Developer with a clean workspace.
Click File » Import > Other » Project Interchange and click Next.

For From zip file, click Browse and to select the directory where the
ClipsAndTacksF1All.zip is saved.

Click Select All and then Finish to import everything.
a. ClipsAndTacksF1 is the completed business process .
b. clips is the monitoring model.
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Run the sample

You can run the sample from the provided artifacts if you did not build the sample
from the tutorial. This section will guide you through the steps to use the provided
solutions and then to run the sample.

1. If you are using the sample from this Web site, you must import the Clips and
Tacks project interchange file. If you are accessing the sample from within
WebSphere Integration Developer, you can skip this step. To import the Clips
and Tacks project interchange file, complete the following steps:

a. Start WebSphere Integration Developer Version 6.1 and create a new
workspace name for this sample, for example C:\Documents and
Settings\ Administrator \IBM\wid6.1\ClipsAndTacks. Do not select Use this
as the default and do not ask again check box because it is easier to come
back to this dialog box if it is not selected. Click OK.

b. Close the Welcome page.

c. Import ClipsAndTacksF1Completed.zip (see [“Download the sample” on|
) into WebSphere Integration Developer by selecting File > Import.

d. Select Other » Project Interchange and then click Next.
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rﬂ Import H

Select \
Import a project and its dependent projects fram a Zip file. | g - E I

Select an import source:

| type filter text |

*-[= General

E? Business Integration
- Vs

#-E EJB

|E? 12EE

E? Plug-in Development
E? Profiling and Logging
®- (= 5IP

®- (= Team

- Test

E? Web

E? Web services

..... ‘HFI‘I——FP

e. Click Browse and select ClipsAndTacksF1Completed.zip.

f. Click Select All. The generated files are not included in the downloaded
ClipsAndTacksF1Completed.zip file to save downloading time. Instructions
on how to generate them are also in this section. Click Finish

IBM WebSphere Clips and Tacks: Getting started with the IBM BPM suite of products



E Import Project Interchange Contents m

Import Projects =
Import Projects from a zip file. [ -
=

From zip file: | C:‘n,WIDSampIEs‘n,EndTnEnd‘n,CIips.ﬁ.ndTadcsNew121?\,CM [Bruwse. = ]

Project location root: | C:\Documents and Setﬁngs\,ﬁ.dminish'ator‘n,IBM‘n,widG.1‘|,|:|E| [Bruwse... ]

= ClipsAndTacksF1

I=+dips

[ Select Al ] [ Deselect All | | Select Referenced

@ Mext = [_Einish ] [ Cancel

2. Generate the process’s User Interface.

a.

When Building Workspace is completed from the import, right-click on
ClipsAndTacksF1 and select Generate User Interfaces.

In the Client Generator Selection window, change Generator type to IBM
Lotus Forms client and click Next.

For the name of the dynamic Web project, enter ClipsAndTacksUI. For the
style, select IBM Style. Click Finish.
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d.

@ User Interface Wizard for Human Tasks

IBM Lotus Forms client configuration

Spedfy destination project, company logo, dient location and style for your dient.

MName of dynamic web project: | ClipsAndTacksUI

S——

Client location

(#) Generated dient and related processes [ tasks reside on the same server.(Local dient view)
) Generated dient and related processes [ tasks reside on different servers. (Remote dient view)
Provider UREL: jiop://fREMOTE_SERVER _IP:BOCTSTRAP_PORT

Style selection

Style:  |IBM Style [w]
Previeyw: MEEE—

2 ’ < Back ]| Next = |[ Finish ” Cancel

A client Generation Completed message appears. Click OK.

3. Generate the monitor model J2EE projects.

a.

b
c.
d

Switch to the Business Monitoring perspective.

Expand clips » Monitor Models.

Right-click clipsbpm.mm and select Generate Monitor J2EE Projects.
Click Finish.
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KE?EFrni:l:tEuhﬂ' =3 =0
&

EIEE dips

EE Event Definitions

EEE Monitor Models
 Ungee
0@ svFles| MW g
#-3Z ClipsAndTacki  OPen

Open With »
Copy
@ Paste

K Delete

Refactor »

Eug Import. ..
7 Export...

" Refresh

Associate Projects...

External Function Libraries. ..
Synchronize with Application. ..
Migrate Manitor Model
Combine Monitor Models. ..

Launch Integrated Test Client

References »

e. Click Finish again.
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€2 Generate Monitor J2EE Projects

Target project names for the generated code

JZEE Projects
Model Logic Project Mame HipsbpmModelLogic
Moderator Project Mame clipsbpmMaoderator

J2EE Application Project Mame | dipsbpmapplication

|:| overwrite existing projects

Finish ] [ Cancel

4. Deploy the executable projects to the server.
a. Select the Servers tab.

b. If the WebSphere Business Monitor Server v6.1 on WebSphere Process
Server is not started, then start it by right-clicking on it and selecting Start.
Then right-click and select Add and Remove Projects.

c. Click Add All
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| o
E Add and Remove Projects H
Modify the projects that are configured on the server

Add and Remove Projects @

Move projects to the right to configure them on the server
Available projects: Configured projects:

B {ClipsAndTacksF 14pp}
#-F ClipsAndTacksUIEAR [ — ]
l% dipsbpmapplication =
Remowve
Add All ==
Remove Al
@ < Back Mext = [ Finish ] [ Cancel

5. To exercise the model, complete the following steps:

a. Open a browser page and type http://localhost:9080/ClipsAndTacksUL
Depending on the number of server profiles on your system, your port
number might be different. To determine your port number, open the
SystemOut.log from C:\Program Files\IBM\WID61\pf\WBMonSrv_wps\
logs\serverl and search for default host. The port number next to the
default host is the port number that you need to use.

b. Enter admin as user ID and admin as the password and click Login. If you
used a different user ID and password during the installation, then you
need to use that user ID and password.

Login to Business User Client

Enter user name and password, then click Login.

Mame: |admin |

Password: |u-u |

The client interface appears as shown below.
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Jol&

(& Setting - Windows Internet Explorer
GO - o o] 1) ] [ccoe |e-
G [ @seso v B @ v oEsee - ook -
-
S
+ HOME ' i
Business User Client
> Business Case
+ New :
~ Business Case
- staus
> My ToDo's - New
~+ Open Selectthis to view a list of all the tasks that you can use to create a business case. For search criteria, you can provide additional
information.
= Claimed
- Status
Select this to view the current state of a process (for example, whether it is running, or finished). You can choose a process from a list,
and then provide search riteria to find a specific instance.
+ Logout
~ My ToDo's
+ Open
Selectthis to claim a task from a list of those that have been started.
+ Claimed
Select this to see a list of the tasks that have already been started and claimed. You can then complete a task by choosing it and
inserting the necessary output data
W Loca nranet Somon -

Dane

c. Under Business Case, click New and then select

OrderHandlingFuturel_InputCriterion. The Lotus Form is displayed.

* For this scenario, when you enter the data, the TotalPrice should be
greater than $750.00 to force the process to flow to the Review task.

¢ Do not enter text below the red text that reads Below this line is for

Clips and Tacks office use only.

* You can add a new row by clicking the + sign; similarly, you can delete a
row by clicking the — sign. You can order multiple items, but ensure there

is only one item per row.

* When you have completed the form, click Create to create a new instance

of the process.

{€ Setting - Windows Internet Explorer

8=

Go- &

G

& & |@senrn

- B @ - e - G-

—

+ HOME . . . N .
B Cases > New > OrderHandlingFuture1 > OrderHandlingFuture1_InputCriterion
> Business Case
Enter the values for the input data and/or provide additional information to create your task.
-+ New
+ Status EEEIEEE LH olwve VO @
> My ToDo's Create)
+ Open

. i \)Clips &Tacks
i

+ Logout
Customer Number [1
Company Name BM
ContactFirst Name [lohn
ContactLastName [Doe
Street Address [100 Main Street
ciy [NewYork
Country jusx

Postal Code [10004

Email ohnDoe@ibmeom
Rating [0
Available Credit 500
Order Number [f01

@

o Lg:
e

= V71 W 4

Done

‘ Product Name ‘Produci Nllmber‘Descripiion ‘Price pamm ‘Ilem Price ‘
[een [pen-t [expensive pen |10 T [“st00000] #] 21 v
<l ] [3]
& Local intranet. H100%

d. Under My ToDo’s, click Open. The order is waiting for the ReviewOrder

task to be approved as shown in the following image.
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| 4 Setting - Windows Internet Explorer m==)
Gi:j' ~ [ http:/focaihost: 08 1 ClpsAndTacksUl faces/Se tting.Jsp o] [##] [] [coogle [[2]-]
w R Igsm'ng ]_} - & - [chpage - G Tooks +

+ HOME
| MyToDo's > Open
Select a task to see more details and finally claim the task.
-+ New
-+ Staus Task Name < Description < First Activated s Originator s
I * My ToDo's -+ OrderHandlingFuture1§0rderHandlingFuture1_ReviewOrder 12M8i07 2:33:36 PM  admin
0
- HpEn Items found: 1 Page 10of1 Items per page:
-+ Claimed
E—
-+ Logout
a) @l
& Local intranet & 100% - B

e. Click the waiting task and then under the form click Claim to work on the
task.

1@ Setting - Windows Internet Explorer =]
) ] (42) (] [cooote (2]
- & - [page - Groos - 7
=
+ HOME , . . .
My ToDo's > Open > OrderHandlingFuture1$OrderHandlingFuture1_ReviewOrder
> Business Case.
Enter the values for the output data of your task
+ New
+ Status BEP S8 ETT £ olwre VWO @
My ToDo's Release| Save| Complete|
= Open Contact Last Name '0027 b
© camed Street Address [100 Main Street
o ,7@ o
-+ Logout Country USA
Postal Code [10004
Email [johnDoe@ibm.com
Rating [100
Available Credit [500.0
Order Number [101
Product Name |Product Number | Description | Price Quantity Item Price
[pen lpen-1 [expensive pen ([10.0 [100 s1.000.00 | *] =]
[pencil [pencil-1 [mechanical pen (5.0 [150 §750.00
Total Price $1,750.00
------- -~ Below this line is for Clips and Tacks office use only -
Order Status | A D
Packing Slip Number [
v
Done &3 Local ntranet #100% ~

f. At the bottom of the form, select the Order Status drop-down list and select
APPROVED. To complete this human task, click Complete (located at the
top left corner of the form).

Note: Save does not complete the human task, but saves the task so that
you can return to it. Click Complete so that the process will continue to the
next task.

g. Click Refresh in the client (not the browser Refresh). Now the task is
waiting for someone to claim and work on the ShipOrdertoCustomer
human task.
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'€ Setting - Windows Internet Explorer []=1 <
@7;} ~ || nmiffocaihostisns 1 CipsandTackeU fsces Settng Jep [ [#2)[x] [ (28

w Ifgsmng

-+ HOME

» Business Case

-+ MNew

>

J
»
Tagks -

[ fi- B @ -G

My ToDo's > Open

Select 2 task to see more details and finally claim the task.

-+ Status Task Name & Description < First Activated & Originator ¢
» My ToDo's -+ OrderHandlingFuture130rderHandlingFuture 1_ShipQrdertoCustomer 121807 2.39:20 PM  admin
5 3
- Heen Items found: 1 Page 1of 1 B Items per page:
-+ Claimed
» User: admin
-+ Logout
)

Done

&3 Local intranet * 100% -

h. Click the waiting task and then click on Claim to work on it.

i. Enter a Packaging Slip number and click Complete to complete the business

process.
/€ Setting - Windows Internet Explorer ™)==
@_\;;v i) o 1/Cii [sed [#2][5¢] [so0gte I[2]-]
P @ snagit |
* & I@smng I_‘ B - B @ < ese - Govs - @ T
+ HOME -
My ToDo's > Open > OrderHandlingFuture1$OrderHandlingFuture1_ShipOrdertoCustomer
B G
| 7 Busesstase Enter the values for the output data of your task.
+ New
- Status B0 28 = S E oo v @
|> My ToDo's Release| Save| G |
- Open Contact Last Name [Doe =
© Camed Street Address 100 Main Street
City [New York
» User: admin
+ Logout Country (USA
Postal Code [10004
Email johnDoe@ibm.com |
Rating [100 1 1
Available Credit [500.0 1
Order Number [101
Product Name | Product Number | Description Price. Quantity Item Price
[pen pen-1 [ pen [10.0 [100 st.000.00 | #] =]
[pencit pencil-1 [mechanical pen |5.0 [150 $750.00
Total Price $1,750.00
Below this line is for Clips and Tacks office use only
Order Status | APPROVED ~
Packing Slip Number [10005
[+
<l Im B @
Done & Local intranet 0% -

You have just processed one instance of the Clips and Tacks OrderHandling
(Futurel) business process. Because the total price of the order was more
than $750.00 and the available credit was less than the total price, the order
went to the ReviewOrder human task (either of the conditions would have
sent it to review). The ReviewOrder human task approved the order and it
went to the ShipOrdertoCustomer human task. The ShipOrdertoCustomer
human task gave it a packaging slip number and sent the order to the
customer.

6. To create the dashboard, complete the following steps:

a. In WebSphere Integration Developer, click Window » Web Browser. The
default browser is 'Internal Web Browser’, but you should not use this one
since some standard functions that you may need are not provided. Select

"Default system Web browser” or any other listed browser other than the
internal browser.
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b. In WebSphere Integration Developer, in the Servers view, right click on
the server WebSphere Business Monitor Server v6.1 on WebSphere
Process Server and select WebSphere Business Monitor Dashboard from
the context menu.

c. When prompted, enter admin for the user ID and enter admin for the
password. You must log in with ‘admin’ so that you can view the alerts
which were setup in Action Services to be viewed by this particular user ID.
Also, in the toolkit environment, this is the user that is automatically
defined on the secured server.

WebSphere ~Business Monitor

d. Click on the Dashboards tab and then the Manage tab.

e. Click Import.
f. Click Browse and select dashboard.data from the unzipped downloaded file
and click OK.

Import

Please select the local file to be imported.

ichClipsaAndTacksMNew! 21 7dashboard. dats| [ Browse... |

g. Click MyDashboard. The dashboard opens.
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E ‘WebSphere Business Monitor Dashboard - Windows Internet Explorer M
g‘; - ‘g‘ https: flacalhost:9444/BusinessDashboard/banner jspUte =true M\‘yHX\ ‘Gc@g\e Hﬁ =
¢ @ snaait B
% 4t | @ websohereeusness Horior Deshaard | | Rt - [ Bage G Tock - @-
Business Monit
walcome admin Layout assistanca Dashboard Layout Help  Logout
Getting Started | Dashboards | Utilities
Manage | MyDashbeard x
—m
Instances -
Model: clipsbpm Version: All Varsions Monitoring Context: OrderHandling (Futura1)
Chack
Order
- . ‘Cancel Order Handling
Acceptable Acceptable ACCqUNtin Accountin ppou.  APBIOVE  dsend Check Customer  Policy for
Credit Risk? Credit Risk? ‘Without - i i i
No Yes Standing?  Standing®  Raviewsno SEVEW?  Eiapsed Elapsed Duration  Approval C'tY COMPLETED  Country
Duration for  for Measure Ela)
Duration
for
Measure
o 100 12.891 s 0.094 s 0.219 s New York * usa
o 100 100 o ss.172 5 10m, 45.422 5 01565  NewYork % usa
o 100 100 o 55.342 = 2m, 58.406 = 0.109 s New York * usa
o 100 im,51.703s 0.084 s 0.187 s Cary * usa
o 100 100 o 55.047 = tm, 54781 01085  NewVork % usa
o 100 100 o im, 6.875s 10h, 9m, 32.125s O.i1s New York * usa
o 100 15.735 s 0.063 = 0.468 s New York *
100 0 o= 8d.2h 49 m 545 0.4385  NewYork usa ]
(e | &
Done & Localintranet # 100% -~ B

h. Optional: To see more data on the dashboard, run more events as described
in Run events to exercise the model from the Build It Yourself section.
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Download the sample

Completed samples are available so that you can start at any stage of this tutorial.
This section shows you how to import the solutions. After you import the model,
you can proceed to the relevant section in the Build It Yourself section to continue
development.

* ClipsAndTacks.pdf — the documentation for running the sample in a book
format that you can print.

* ClipsAndTacksForModeler.zip — the completed process model to be imported
into WebSphere Business Modeler

* ClipsAndTacksF1.zip - the completed process model to be imported into
WebSphere Integration Developer for further development.

* ClipsAndTacksF1Completed.zip — the completed process model and monitor
projects, without generated files, to be imported into WebSphere Integration
Developer, ready to deploy.

¢ Order.xfdl — the Lotus form used in this tutorial

* CreditRating.java — the Java file used in this tutorial to check the customer
account status.

¢ Dashboard.data — a pre-built dashboard for ClipsAndTacks

* OrderHandling (Futurel).mm — the monitor model exported from WebSphere
Business Modeler

¢ OrderHandling_ x0028_Futurel_x0029__KM_OrderHandling_ x0028_Futurel
_x0029__KC.svg — an SVG image of the business process to be used with the
KPIs in the monitor model. This file is exported from WebSphere Business
Modeler

* OrderHandling_ x0028_Futurel_x0029__MDM_OrderHandling_x0028_Futurel
_x0029__MC.svg — an SVG image of the business process to be used with the

metrics (monitoring context) in the monitor model. This file is exported from
WebSphere Business Modeler

Use the following sections to import the model using either WebSphere Business
Modeler or WebSphere Integration Developer.

* [“Importing the completed model into WebSphere Business Modeler”|

* |"Importing the completed model into WebSphere Integration Developer” on|

[page 5—2]

¢ |“Importing the completed WebSphere Integration Developer project into|
WebSphere Integration Developer” on page 5-2|

Importing the completed model into WebSphere Business Modeler
The completed process model is ClipsAndTacksForModeler.zip.

To import ClipsAndTacksForModeler.zip, complete the following steps:
1. Start WebSphere Business Modeler with a new workspace.

2. Click File » Import » WebSphere Business Modeler >+ WebSphere Business
Modeler Import and click Next.

3. Select WebSphere Business Modeler project (.mar, .zip) and click Next.



4. Click Browse and select the directory where the ClipsAndTacksForModeler.zip
is saved.

5. Select ClipsAndTacksForModeler.zip and click Finish.

Importing the completed model into WebSphere Integration Developer

The completed process model for importing into WebSphere Integration Developer
is ClipsAndTacksF1.zip.

To import ClipsAndTacksF1.zip, complete the following steps:
1. Start WebSphere Integration Developer with a new workspace.
2. Click File » Other » Project Interchange and click Next.

3. For From zip file, click Browse and select the directory where the
ClipsAndTacksF1.zip is saved.

4. Select ClipsAndTacksF1 and click Finish.

Importing the completed WebSphere Integration Developer project into
WebSphere Integration Developer

The completed process model and monitor model for importing into WebSphere
Integration Developer is ClipsAndTacksF1Completed.zip.

To import the completed projects, complete the following steps:
1. Start WebSphere Integration Developer with a clean workspace.
2. Click File > Import > Other > Project Interchange and click Next.

3. For From zip file, click Browse and to select the directory where the
ClipsAndTacksF1All.zip is saved.

4. Click Select All and then Finish to import everything.
* ClipsAndTacksF1 is the completed business process .
¢ clips is the monitoring model.
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